Using the GO Computer

Connecting to a Personal Computer
Using the GO Computer
Trademarks

Apple
AppleTalk
IBM
LocalTalk
Macintosh ...
MSDOS ...
Novell...
OS/2 ...

PostScript is a registered trademark of Adobe Systems Inc.
The spelling portion of this product is based on Spelling and Thesaurus Technology from Franklin Electronic Publishers.

The PROXIMITY/Merriam-Webster LINGUIBASE
Copyright © 1983
Merriam-Webster, Inc.
Copyright © 1983. All Rights Reserved
Proximity Technology, Inc.

Words are checked against the 83,000 word Proximity/Merriam-Webster Linguibase.

SoftTalk
TOPS
UNIX is a registered trademark of AT&T.
All other products or services mentioned in this document are identified by the trademarks or service marks of their respective companies or organizations.
# Table of Contents

## Chapter 1  
**Fundamentals**

- Noteook Structure  
  - Notebook Structure
- Interacting with the Go Computer  
  - Giving Commands with Gestures and Menus
  - Using the Items on the Bookshelf
  - Training PenPoint in your Handwriting
  - Using Option Sheets  
    - Displaying Option Sheets
    - Choosing Options
- Making a Selection  
  - Making A Selection
- Copying and Moving Information  
  - Copying and Moving Information
- Getting Help  
  - Getting Help
    - Getting Quick Help
    - Using the Help Notebook

## Chapter 2  
**Drawing Gestures**

## Chapter 3  
**Installing Programs and Utilities**

## Chapter 4  
**Creating and Using Documents**

- Creating a Document  
  - Using the Create Menu
    - Using the Stationery Notebook
    - Adding Stationery to the Create Menu
Renaming a Document
Customizing a Document

DISPLAYING AND POSITIONING DOCUMENTS
Scrolling a Document
Floating a Document
Moving and Resizing Floaters
Zooming a Document

USING COMPOUND DOCUMENTS
Embedding a New Document
Embedding an Existing Document
Working with Embedded Documents
  Setting Document Options
  Moving an Embedded Document
  Floating an Embedded Document
  Making an Embedded Document a Full-page Document
  Printing an Embedded Document

STATIONERY
Creating Stationery
  Creating Customized Stationery
Managing the Stationery notebook

MOVING AND DELETING DOCUMENTS

CHAPTER 5
WRITING IN THE NOTEBOOK
Printing in Writing Pads
  Printing in the Writing Pad
Translating Your Handwriting
Correcting the Translation
  Correcting the Translation in the Writing Pad
  Correcting the Translation with the Proof Sheet
Using Writing Pads
  Getting a Writing Pad
  Choosing a Writing Pad Style
  Using a Keyboard to Write
CHAPTER 6
EDITING AND FORMATTING TEXT

EDITING TEXT
Selecting Text
Editing Text within a Document
  Adding Text
  Deleting Text
  Inserting Text in Translated Text
Editing Text in Editing Pads
Editing Labels, Document Titles, and Fields
  Editing Fields
Moving and Copying Text
  Moving or Copying Text

FORMATTING TEXT
Styling Text
  Styling Text Directly
  Styling Text with Text Option Sheets
Formatting Text
  Setting Margins
  Changing Line Spacing
  Positioning the Text
  Setting Tabs
  Starting a New Line, Paragraph, or Page
  Copying a Format or Style
Viewing Text
  Viewing Text
  Magnifying the Text
Checking Your Spelling
  Adding a Word to the Dictionary

ADDING A SIGNATURE
Adding your Signature to a Document
CHAPTER 7
FINDING AND REPLACING TEXT

FINDING AND REPLACING TEXT
Finding Text
Replacing Text

FINDING AND REPLACING INFORMATION
Defining the Search
Setting the Search Range
Setting the Position and Direction
Refining the Search

CHAPTER 8
MANAGING THE NOTEBOOK

ORGANIZING THE NOTEBOOK
Seeing What's in Your Notebook
Finding Out More About a Document
Using the Show menu
Using the Document Option Sheets
Printing the Table of Contents
Sorting the Table of Contents
Rearranging the Notebook
Moving Pages
Grouping Documents into Sections
Creating a Section
Moving a Document into a Section
Creating a Subsection

MOVING AROUND THE NOTEBOOK
Turning to a Page
Using Notebook Tabs to Mark Pages
Attaching and Deleting Tabs
Attaching Several Tabs
Displaying Tabs
Using GoTo Buttons to Move Between Pages

CUSTOMIZING THE NOTEBOOK
Setting Preferences
CHAPTER 1

Fundamentals
Notebook Structure

Each page of the Notebook contains a different document. You can have as many pages in the Notebook as you want (up to the amount of available memory).

A document can be longer than what you see on the screen. You can bring the hidden part into view by scrolling. You'll find details in "Scrolling a Document" in chapter 3 (Creating and Using Documents).

A document can be longer than what you see on the screen.

Tap the scroll arrows to see the off-screen portions.
As in a paper notebook, you can organize the pages by grouping them into sections. The name of each document and section is listed in the table of contents, which is on the first page of the Notebook.

To get to a particular document you can turn pages or tap the page number in the Notebook table of contents. But if it's a document you use frequently, you might want to attach a notebook tab to it. Then you can go directly there by tapping the tab.

To see what's in the Notebook:
- Tap the Contents tab to see the table of contents for the entire Notebook
- Tap a notebook tab to go to a specific document
When you work with the documents in your Notebook, you:

Choose menu commands.

- Tap a menu name to open it and see its choices. Tap again to choose a command.

- Dimmed commands are currently unavailable.

Draw gestures symbols or letters that tell PenPoint what to do.

- The gesture profiles in chapter 2 show you how to draw each kind of gesture.

(If you don’t see the menu line, you may have zoomed the page so that it takes up the full screen. Draw a flick down on the title line to restore the page to its normal size.)
The bookshelf holds additional small notebooks and accessories which you use for different tasks, such as sending and receiving mail. These specialized notebooks are represented by icons.

The Help notebook gives brief instructions about how to use the GO Computer and PenPoint.

Preferences lets you set options such as the way icons look and the layout of the screen.

The Stationery notebook contains sample documents that you copy to create new pages in your Notebook.

You use the Installer to add programs to your Notebook.

Use the Inbox and Outbox to send and receive electronic mail, faxes, and files.

The DiskViewer lets you see what's on other disks or computers.

You use the Device notebook to set up printers.

The Keyboard is an on-screen keyboard that you tap to enter data.

The Accessories notebook contains things like the clock and Handwriting Trainer.
Dear Ms. Huerta:

We need condiments. A few weeks ago, a box of condiments left the office. It left the 5-year-old's hair. Our bottles of confetti are all over the floor near the box.

The executive says that he never got a chance to try the sauce, but now his Doberman won't eat his dog food without it.

Can you help us design a lightweight, recyclable plastic bottle that was on the floor near the box?
Training PenPoint in your Handwriting

You'll find the Handwriting Trainer in the Accessories icon along with such things as the clock. You can store other accessories you acquire for the GO Computer here.

1. Tap the Accessories icon to open it.
2. Tap Handwriting Trainer to turn there.
3. Follow the instructions on the screen to practice printing letters clearly and to teach PenPoint how you habitually form your letters.
4. To save your handwriting profile.
   ▲ You can return to the Handwriting Trainer at any time to teach PenPoint more about a specific letter it may translate incorrectly.
Option sheets allow you to specify the scope of a menu command or to set attributes such as a font for text or the icon size for an item on the bookshelf.

You’ll often see an option sheet when you choose a menu command that’s followed by three periods (an ellipsis). Otherwise you ask for one by using check or the Edit menu.

Option sheets may prompt you for further information before carrying out a command. For example, if you choose Find, PenPoint asks what you want to find. You fill in the requested information by writing in a text field or by choosing options.

Displaying Option Sheets

To see the options for:

- Text: Draw a check on selected text. Or, select the text and choose Options from the Edit menu.
- Documents: Draw a check on the document title in the table of contents. Or, select the title and choose Options from the Edit menu.
- Bookshelf icons and Goto Buttons: Draw a check on the object.

Sometimes there will be more than one option sheet. An arrow on the title line indicates there’s more than one.

1. Draw a check on the word to display the text option sheet
2. Tap to see a list of the other option sheets
3. Reposition the option sheet by dragging the gray border
4. Resize the option sheet by dragging the bottom handle

Using Option Sheets
Choosing Options

1. Tap to see the Character options sheet if it's not already displayed.
2. Tap to select an option.
   - Double lines indicate that you can choose more than one option. Tap each one you want. If you change your mind, tap again to clear your choice.
   - A single line indicates that you can only choose one; tap the option to see the other choices; tap to select one.
3. Tap to display the Paragraph options sheet.
4. Enter information in a text field by writing in it.
   - To change a text field entry, draw a cross out X through the text and write in new text.
5. Tap the appropriate action button:
   - To apply your choices and continue using the sheet, tap Apply.
   - To close the sheet without applying the choices, tap Close.

To find out more about how to edit text in fields, see Editing Labels, Titles, and Fields in Editing and Formatting Text (chapter 5).
Sometimes it's obvious what you want your commands to apply to. For example, to style a word in boldface, you draw a $B$ over it. At other times, you need to tell PenPoint what to act on by first selecting it. For example, to make an entire sentence bold, you select it and then draw a $B$ over the selection. Selected text looks different: the background is dark and the letters are light.

To select a single character hold the pen on the character until you see it highlighted.

To select a word, sentence, or paragraph use taps. For example, a doubletap selects a word.

To select a series of letters, hold the pen down until you see the character beneath the pen highlighted and then drag to the end of the selection.

Draw brackets [ ] to select the enclosed text.

Draw a new bracket [ to adjust the selection.

To select an entire document tap the entry in the table of contents.
MAKING A SELECTION
MAKING A SELECTION

To find more about using gestures to select text read Selecting Text in chapter 5 (Editing and Formatting Text).

To clear text you've selected, tap in the text somewhere outside the selection. To clear a part of the Notebook you've selected with a plus +, draw a plus + on it again.
You can use gestures to copy \{tap hold drag\} or move \{hold drag\}:

- a document to another location in the Notebook
- information to another place on the page
- information between pages.

To move a sentence from one place on a page to another:

1. Tap three times to select the sentence.
   - Lift your pen away from the screen after each tap, but make the three taps in fairly quick succession.
   - You know the sentence is selected when the background turns dark and the letters light.

2. Select Move from the Edit menu.
   - The sentence is temporarily replaced by an icon, which is surrounded by an animated border.

3. Drag the icon to its destination and lift the pen away from the screen.
   - (Where you lift the pen determines where the text goes.)

PenPoint moves the sentence to the new location.
When you copy or move more than a line of text, PenPoint temporarily represents it as an icon to make it easier to drag. If you turn to a different page, the icon follows.

To move a document to a different location in the Notebook:

✔ Start from the table of contents. Put the pen down on the title and hold it there until you see the animated border on the title which tells you it’s ready to be moved.

✔ Drag the title (and the document along with it) to another place on the table of contents.

✔ Lift the pen away from the screen.

The animated border disappears, and the document is moved to its new location. Note that the page number for the document has changed to reflect its new location.

You can also select what you want to copy or move and then choose the appropriate command from the Edit menu.
Getting Help

You can get two kinds of help from PenPoint: Quick Help and the Help notebook. Use Quick Help when you see something on the screen you want to know more about, and the Help notebook when you want to look up a topic. You can continue working while displaying either kind of help.

Getting Quick Help

Quick Help briefly describes the part of the Notebook or page you asked about and lists the gestures that work there.

1. Draw a question mark (?) over whatever you want Quick Help about.

   You'll see a brief description of it, along with a list of gestures you can use in this area.

   ▲ If you turn to a different page in the Notebook, Help goes with you.

2. Tap to close Help.

If the information doesn't fit on the Quick Help page, you can bring the hidden part into view by pressing the top (?) arrow in the scroll margin.
Using the Help Notebook

The Help notebook organizes information topically so that you can find out how to use different features of the GO Computer or the programs you’ve installed on it.

1. Tap the Help icon once to open it.
2. You’ll see instructions on using the Help notebook.
   - Tap on the appropriate page number in the Help table of contents to see a particular topic.
3. Tap the close corner to close the notebook.

To move the notebook to see what’s below it, drag the title line.
You use gestures to give commands to PenPoint and to edit text in a document or text field. Most gestures have corresponding menu commands, but you'll find that the gesture is usually faster.

You can learn about gestures from the gesture profiles in this chapter. The profiles show you how to draw gestures, what part of the gesture actually activates a command, where gestures work, and what their effect is in each place you use them.

PenPoint interprets gestures in the same way it does your handwriting. As in handwriting, neatness and consistency are most important. You'll get the best results if you draw gestures with a light, firm touch, and straight lines free of hooks or extensions.

PenPoint interprets a gesture as complete when you lift your pen away from the screen. If a gesture has more than one stroke, keep the pen very close to the screen as you lift it between strokes, until you've completed the gesture.

The profiles in this chapter contain other important information. For example, the italics gesture requires a Roman-style capital I with three lines that may differ from the way you practice your uppercase I in the Handwriting Training. If you make a gesture and it doesn't work, refer to it in the gesture profiles.

Programs you install in your Notebook may add their own gestures. Refer to those manuals for more information.
**PENPOINT GESTURES TABLE**

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• TAP</td>
<td>Selects or activates what you touch.</td>
</tr>
<tr>
<td>•• DOUBLE TAP</td>
<td>Selects a word in text; floats a page.</td>
</tr>
<tr>
<td>••• TRIPLE TAP</td>
<td>Selects a sentence.</td>
</tr>
<tr>
<td>•••• QUADRUPLE TAP</td>
<td>Selects a paragraph.</td>
</tr>
<tr>
<td>☿ PRESS</td>
<td>Makes a character box in a writing pad active; sets an insertion point in text.</td>
</tr>
<tr>
<td>• — TAP-PRESS-DRAG</td>
<td>Copies a selection or object.</td>
</tr>
<tr>
<td>☿ PRESS-DRAG</td>
<td>Moves a selection or object; selects a series of characters.</td>
</tr>
<tr>
<td>✗ CROSS-OUT</td>
<td>Deletes text, icons, and other objects. When drawn in a document title line, deletes the document.</td>
</tr>
<tr>
<td>○ CIRCLE</td>
<td>Opens a pad for editing a word or selection in text, fields, document titles, and labels on tabs and buttons.</td>
</tr>
<tr>
<td>☑ CHECK</td>
<td>Displays options for the text or object that you check.</td>
</tr>
<tr>
<td>▲ CARET</td>
<td>Opens a small pad for inserting text; opens the Create menu in the Table of Contents to create a new document.</td>
</tr>
<tr>
<td>? QUESTION MARK</td>
<td>Opens Quick Help for the menu item, icon, or other object the gesture is drawn over.</td>
</tr>
<tr>
<td>[ ] BRACKETS</td>
<td>Selects text; extends or reduces text selections.</td>
</tr>
<tr>
<td>— HORIZONTAL PIGTAIL</td>
<td>Deletes words in text.</td>
</tr>
<tr>
<td>—— DELETE IN PADS</td>
<td>Deletes words in the proof sheet and editing pad character boxes.</td>
</tr>
<tr>
<td>/ VERTICAL PIGTAIL (Text)</td>
<td>Deletes individual characters in a document or text field.</td>
</tr>
<tr>
<td>Gesture</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>/</td>
<td>VERTICAL PIGTAIL (Pads) Deletes individual characters in the writing and editing pad character boxes.</td>
</tr>
<tr>
<td></td>
<td>INSERT SPACE (Text) Adds a space.</td>
</tr>
<tr>
<td></td>
<td>INSERT SPACE (Pads) Adds one or more spaces in the writing and editing pads.</td>
</tr>
<tr>
<td>↑</td>
<td>FLICK (UP/DOWN) Scrolls the line you flick on to the top or bottom of documents and tables of contents.</td>
</tr>
<tr>
<td></td>
<td>FLICK (LEFT/RIGHT) Scrolls the column you flick to the left or right in documents and tables of contents. On a document's title line, turns to the next or the previous page.</td>
</tr>
<tr>
<td>↑↑</td>
<td>DOUBLE FLICK Scrolls to the top, bottom, extreme left, or extreme right of a document.</td>
</tr>
<tr>
<td>+</td>
<td>PLUS Selects or deselects GoTo buttons, icons, embedded documents, and names in the Send list.</td>
</tr>
<tr>
<td>-</td>
<td>SCRATCH-OUT Deletes characters in character boxes, text, writing pads, and fields.</td>
</tr>
<tr>
<td></td>
<td>CIRCLE-LINE Opens a blank editing pad in text.</td>
</tr>
<tr>
<td>ᴣ</td>
<td>CARET-TAP Creates a large writing pad.</td>
</tr>
<tr>
<td>ᵇ</td>
<td>CHEVRON Creates an embedded document.</td>
</tr>
<tr>
<td>☺</td>
<td>DOUBLE CIRCLE Creates a GoTo button.</td>
</tr>
<tr>
<td>↑↓</td>
<td>ARROW UP/DOWN Increases or decreases the size of selected text.</td>
</tr>
<tr>
<td>ᵤ</td>
<td>UP-RIGHT Opens a single-character writing pad.</td>
</tr>
<tr>
<td>↓</td>
<td>DOWN-LEFT Adds a paragraph break.</td>
</tr>
<tr>
<td>Gesture</td>
<td>Function</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DOWN-LEFT-FLICK</td>
<td>Adds a one-line break in text without beginning a new paragraph.</td>
</tr>
<tr>
<td>DOWN-RIGHT-FLICK</td>
<td>Adds a tab in a document.</td>
</tr>
<tr>
<td>RIGHT-UP</td>
<td>Formats text with initial capital letters.</td>
</tr>
<tr>
<td>RIGHT-UP-FLICK</td>
<td>Formats text as upper case.</td>
</tr>
<tr>
<td>RIGHT-DOWN</td>
<td>Formats text as lower case.</td>
</tr>
<tr>
<td>CHECK-TAP</td>
<td>Displays options for an embedded document.</td>
</tr>
<tr>
<td>PROOF</td>
<td>Opens a proof sheet with possible spellings and translations for editing a word.</td>
</tr>
<tr>
<td>EJECT FLOPPY</td>
<td>Ejects a floppy disk. Works on icons and disk titles in the diskviewer.</td>
</tr>
<tr>
<td>FIND</td>
<td>Opens a dialog sheet that lets you search a document or selection for a specific word.</td>
</tr>
<tr>
<td>SPELL</td>
<td>Opens a dialog sheet that lets you check the spelling of a document (gesture in document title line) or selection (gesture in selection).</td>
</tr>
<tr>
<td>BOLD</td>
<td>Makes text bold. Works on a word or selection.</td>
</tr>
<tr>
<td>ITALIC</td>
<td>Makes text italics. Works on a word or selection.</td>
</tr>
<tr>
<td>MENU</td>
<td>Shows or hides the Menu line. Works in the document title line.</td>
</tr>
<tr>
<td>NORMAL</td>
<td>Makes text plain. Works on a word or selection.</td>
</tr>
<tr>
<td>TAB</td>
<td>Shows or hides tabs. Works in the Table of Contents on document titles, section titles, and in documents on the title line.</td>
</tr>
<tr>
<td>UNDERLINE</td>
<td>Underlines text. Works on a word or selection.</td>
</tr>
<tr>
<td>CORK MARGIN</td>
<td>Shows or hides the cork margin. Works in the document title line.</td>
</tr>
</tbody>
</table>
What it does: Selects or activates what you touch with the pen.

Draw: Touch the screen firmly, then quickly lift the pen. Wait a moment for the Lombard to carry out your instruction.

What doesn’t work: Pressing too hard, tapping repeatedly, "coloring in" the tap; hovering too close to the screen after tapping.

Where else it works:

- Chooses
  - Menu
  - Commands

- Carries out instructions
  - Apply

- Turns to Page
  - (Table of Contents)

- Turns Pages
  - <233>

- Closes Floaters

- Opens icon on bookshelf

- Turns to page with tab on it
**DOUBLE TAP**

*What it does:* Selects a word in text; floats a page; expands or collapses section contents in Table of Contents.

*Draw:* Touch the screen firmly twice, barely lifting the pen between taps. Then lift the pen away from the screen.

- Double tap on a word to select the word
- Double tap on a Table of Contents page number to open the page floating
- Double tap on a tab to float the tabbed page

*What doesn't work:* Lifting the pen tip too far between taps; tapping on two different objects or words.

*Where else it works:* A double tap on a GoTo button floats the page attached to the goto button.
<table>
<thead>
<tr>
<th>TRIPLE TAP</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What it does:</strong> Selects a sentence.</td>
</tr>
<tr>
<td><strong>Draw:</strong> Touch the screen firmly three times, barely lifting the pen between taps. Then lift the pen away from the screen.</td>
</tr>
<tr>
<td><strong>What doesn’t work:</strong> Lifting the pen tip too far between taps.</td>
</tr>
<tr>
<td>QUADRUPLE TAP</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td><strong>What it does:</strong> Selects a paragraph in text.</td>
</tr>
<tr>
<td><strong>Draw:</strong> Touch the screen firmly four times, barely lifting the pen between taps. Then lift the pen away from the screen.</td>
</tr>
<tr>
<td><strong>What doesn’t work:</strong> Lifting the pen tip too far between taps.</td>
</tr>
</tbody>
</table>
What it does: Selects a single text character; sets the space immediately before the selected character as an insertion point; makes one character box in a writing pad active (it is underlined).

Draw: Touch the screen on the character or character box that you want to select until it is highlighted (about one second) and then lift your pen away from the screen.

What doesn't work: Tapping (lifting the pen away from the screen too quickly).
**TAP-PRESS-DRAG**

*What it does:* Selects and copies a word or object, and moves the copy to the desired location.

*Draw:* Tap the screen and barely lift the pen (this selects the word or object), then touch the screen again and keep the pen tip in contact. You'll see a moving double-dashed line around the selection when it's ready to be copied. Then, still without lifting the pen, drag the selection to the desired location. Lift the pen where you want to place the copy.

When the [selection] has a double-dashed line around it, you can drag the copy to its destination.

*What doesn't work:* Tapping repeatedly; "coloring in" the tap; lifting the pen too far after tapping; not waiting for the moving, double-dashed line to enclose the selection or object; lifting the pen before you finish dragging the selection or object.

*Where else it works:* Copies a selection in text, copies documents in the table of contents, and copies bookshelf icons.
What it does: Moves a text selection or a selected object; selects a series of text characters.

To move an object or selection: Touch the object or selection with the pen tip and wait until you see a double-dashed line around the object or selection; then, without lifting the pen, drag the object or selection to the intended location. An object will be moved to the precise point on the screen where you lift the pen; selected text will be moved to the whole space nearest the point where you lift the pen.

To select text: Touch the pen to the screen and wait for the first character to be highlighted; then, without lifting the pen, drag the pen through the characters to the last text character you want to include in the selection.

What doesn't work: Lifting the pen before the double-dashed line forms around the selection, or before you finish dragging the selection or object.

Where else it works: Moves documents in the Table of Contents and diskviewer; moves bookshelf icons; dragging from the document title line, moves open floating documents.
What it does: Deletes the object or selection directly beneath the X.

Draw: Make an X, using two distinct strokes, over the selection or object that you want to delete.

What doesn’t work: Drawing the gesture in one stroke (connecting the two lines); making a + instead of an X; drawing strokes that are not clean lines.

Where else it works: Deletes contents of a field, documents from the table of contents, and icons from the bookshelf; when drawn in a document’s title line, deletes the document.
What it does: Opens an editing pad in text, text fields, and labels for a character, word, or short series of words.

Draw: Start anywhere in the area (character, word, series of words) that you want to edit and complete a neatly closed circle; ovals also work.

Ovals work. ☺ ➔ O V Φ L
(Opens a pad to edit just the u in "ovul.")

(Opens a pad to edit the whole word "ovul.")

What doesn't work: Not starting the circle from the top.

Overlapping parts of the circle too much (overlapping a little is okay)

Not closing the circle

Where else it works: Opens an editing pad for a document name in the Table of Contents, a document title, or a label on a tab, icon, or GoTo button.
What it does: Displays options for a word in text, or the selection or object over which you draw the check.

Draw: Draw the check in one gesture, with the beginning of the first downward stroke on the object whose options you want to see.

- **Up**
- **Down**
- **Or mirror**

What doesn't work: Drawing the check at a horizontal or vertical angle; unclean lines (hooked).

- Vertical (similar to add space gesture)
- Horizontal (similar to new line gesture)
- Hooked

Where else it works: Displays options for text, icons, documents (when drawn in the document title line), tables of contents (when drawn in the table of contents title line), and accessories (when drawn in the title line of the accessory).
What it does: Opens a small pad for inserting text; opens the Create menu in the Table of Contents to create new documents.

Draw: Starting the gesture at the lower left, make an upside-down V, and a writing pad pops up above the tip of the gesture; the tip of the gesture sets the insertion point for the new text.

What doesn't work: Making two strokes; creating a loop at the tip; starting on the right side of the caret; or cluttering the gesture with extra hooks or wiggles.

These caret gestures won't work.
What it does: Opens Quick Help.

Draw: Draw a question mark over any screen element to see Quick Help for that element. For best results, draw the question mark so that the loop joins the stem over the center of the target. Don't forget the dot (and don't lift the pen tip too far before making it).

What doesn't work: Drawing the question mark off the center of the object you want help in understanding; failing to dot the question mark; making an elongated question mark.

Where else it works: Labels (the left column) on option sheets.
**BRACKETS**

**What it does:** Brackets is really two gestures, which select the words enclosed by the brackets. Once a selection is made, you can move either or both brackets to increase or decrease the selection. If you draw through a character with the left bracket, that character will be inside the selection; if you draw through a character with the right bracket, it will be outside the selection. If you place an insertion point into text, a bracket will extend its selection to the insertion point without need of the second bracket.

**Draw:** In one stroke, starting at the top, draw three sides of a rectangle (you can draw either bracket first; a beginning bracket opens to the right; a closing bracket opens to the left).

<table>
<thead>
<tr>
<th>Selects</th>
<th>Selects words or characters.</th>
</tr>
</thead>
</table>

**What doesn’t work:** Drawing from the bottom up; extremely curved or pointed lines; curled or cupped bracket legs.

| < | < |

**Where else it works:** You can use a single bracket to adjust a selection’s contents even if you created the selection in some other way.
**HORIZONTAL PIGTAIL**

*What it does:* Deletes words in text and translated text from character boxes in pads. Deletion begins at the start of the horizontal line and ends at the loop. The "tail" following the loop doesn't delete anything.

*Draw:* From left to right, make a horizontal line with an upward loop.

```
this delete one or more words results in this delete words
```

*What doesn't work:*

```
delete one or more words downward loop
delete one or more words slanting the line
delete one or more words drawn right to left
```
What it does: Deletes translated text from character boxes.

Draw: A horizontal line through the letters you want to delete.

What doesn't work: Drawing the line from right to left.

slanting the line too much (some slanting is okay)
<table>
<thead>
<tr>
<th>VERTICAL PIGTAIL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What it does:</strong> Deletes individual characters in a document or text field.</td>
</tr>
<tr>
<td><strong>Draw:</strong> A vertical line with a loop at the end.</td>
</tr>
</tbody>
</table>

**For the best results:** Begin the gesture within the boundaries of the character you want to delete (the place first touched by the pen tip determines what is deleted); draw it straight through, create the loop above the character, and end with a straight line.

delete a single character.

**What doesn't work:**

<table>
<thead>
<tr>
<th>two</th>
<th>two</th>
<th>two</th>
</tr>
</thead>
<tbody>
<tr>
<td>ends with a circle</td>
<td>begins above the character</td>
<td>starts with a loop</td>
</tr>
<tr>
<td>slanted, drawn through several letters</td>
<td>begins below the character</td>
<td>ends with a curved line</td>
</tr>
</tbody>
</table>
**VIRTUAL PIGTAIL**

*(Pads)*

**What it does:** Deletes individual characters in the writing and editing pad character boxes.

**Draw:** Begin the vertical line within the character box and extend it through the top of the box, ending with a loop. The loop is the key to differentiating this gesture from a flick, so don't worry about the length of the "tail" you leave after the loop.

![Gesture示意图]

**What doesn't work:**

- b e s s t
  - gesture ends inside the character box
  - translated as a letter

- b e s s t
  - slants too much
  - gesture starts below box
<table>
<thead>
<tr>
<th>INSERT SPACE</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Text)</td>
</tr>
</tbody>
</table>

**What it does:** Inserts one space.

**Draw:** With one down-right stroke, make a capital letter L between the letters you want to separate. (If you touch a character, it will be on the right side of the space that is opened.)

- insert a space between letters

**For the best results:** Start the gesture in the middle of the line, because the place where the pen first touches sets the insertion point. To insert more than one space repeat the gesture.

- To insert: repeat the gesture
- To insert: repeat the gesture
- To insert: repeat the gesture

**What doesn’t work:** Touching the character to the left of where you want to insert the space.

- gesture begins too high: insert a space
- not a right angle: insert a space
What it does: Adds one or more spaces in the writing and editing pads.

Draw: With one down-right stroke, make a capital letter L. Begin it in the middle of the character box that you want to insert the space before, and end the gesture below the box.

```
| b | e | l | w |
```

Make the bottom line the length of one character box if you want to insert one space, two to insert two spaces, and so forth.

```
| b | e | l | w |
| b | e | l |
```

What doesn't work:

- the entire gesture is within the box
- the vertical leg is drawn on the character box line
- the gesture is drawn at an odd angle
What it does: Scrolls text in documents (scroll margins, or anywhere on a page) and Table of Contents.

Draw: Make a straight vertical line (any length); start the flick where you want the scroll to begin.

vertical flicks

What doesn’t work: Gestures that are at odd angles; hooks at beginning or end of flicks; touching the screen too slowly before starting to flick.

odd angles
don’t work

Where else it works: Scrolls the choices in an option sheet. In a document header, zooms and reduces the page view. Exposes and hides tab labels.

Flick on hidden tabs to see/hide labels

Flick up here to reveal hidden tab
<table>
<thead>
<tr>
<th>FLICK (LEFT/RIGHT)</th>
</tr>
</thead>
</table>

*What it does:* Scrolls documents and the Table of Contents left or right. On the document title line, turns to the next or previous page.

*Draw:* Make a straight horizontal line (any length).

<table>
<thead>
<tr>
<th>previous page</th>
<th>next page</th>
</tr>
</thead>
<tbody>
<tr>
<td>scroll left</td>
<td>scroll right</td>
</tr>
</tbody>
</table>

*What doesn't work:* Gestures that are at odd angles; hooks at beginning or end of flicks; touching the screen too slowly before starting to flick.

| odd angles | don't work |

*Where else it works:* In a notebook with many tabs, flick-left displays tabs in discreet columns so that all are visible; any gesture puts them back into one column.
## DOUBLE FLICK

**What it does:** Scrolls to the top, bottom, left, or right edge of a document.

**Draw:** Start the flick where you want the scroll to begin and make a straight line of any length; barely lift the pen tip and then make a second flick.

**What doesn't work:** Flicks that are at odd angles or made in different directions; lifting the pen too far before making the second flick; hooks at the beginning or end of flicks; touching the screen too slowly before starting to flick.

**Where else it works:** You can flick anywhere in a document, in the scroll margin, and in tables of contents; on a document title line, scrolls to the Table of Contents.
**What it does:** Selects or deselects GoTo buttons, icons on the bookshelf, embedded documents, names on the Send list.

**Draw:** Make two strokes at right angles, keeping the pen tip close to the screen between strokes. Start with the downward line; draw the horizontal line from either direction. The gesture's lines should intersect directly over the selection, icon, or button you want to select or deselect.

![Diagram of a plus sign]

**What doesn't work:** Making an "x" instead of a "+"; not lifting the pen enough to separate the two parts of the gesture; lifting the pen tip too far between drawing the two lines; hooks at the beginning or end of lines.

- too X-like
- joined
- hooked
<table>
<thead>
<tr>
<th>SCATCH-OUT</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What it does:</strong> Deletes characters and words in text, and in writing pads and fields.</td>
</tr>
<tr>
<td><strong>Draw:</strong> Three horizontal lines back and forth on top of each other without lifting the pen (a very compressed Z).</td>
</tr>
<tr>
<td>DELETE A WORD</td>
</tr>
<tr>
<td><strong>What doesn’t work:</strong></td>
</tr>
<tr>
<td>loose zigzags</td>
</tr>
<tr>
<td>disconnected lines</td>
</tr>
</tbody>
</table>
What it does: Opens a blank editing pad for a word in text, or for selected text, to allow you to replace the word or words.

Draw: Over the word or within the selection that you want to replace, draw a circle or oval, then make a horizontal line across the middle of it. Lift the pen tip no more than the barest distance from the screen before drawing the line, which you may begin from either the right or left.

On a single word A plain circle gesture opens a pad filled with text. A circle-line gesture opens a blank pad.

On a selection A plain circle gesture opens a pad filled with text. A circle-line gesture opens a blank pad.

What doesn't work: Lifting the pen too far before drawing the line; too much angle on the horizontal line; too much overlapping or failing to close the circle or oval.

Too much angle
What it does: Creates a large writing pad.

Draw: Starting the gesture at the lower left, make an upside-down V, and then, barely raising the pen, tap over the caret point.

What doesn't work: Tapping too far off-center; making the tap too far inside the caret; lifting the pen tip too far before tapping.
CHEVRON

**What it does:** Creates an embedded document.

**Draw:** Two carets, one nested beneath the other (either upper or lower can be made first). Each caret gesture should be drawn from left to right with one stroke; just barely lift the pen before making the second caret.

![Center point of the gesture](image)

**What doesn't work:** Using more than two strokes to make the gesture; making either caret from right to left; making sloppy carets with extra hooks or wiggles; lifting the pen tip too far before making the second caret.

![Too much overlapping](image)  ![Too much space between the carets](image)
What it does: Creates a GoTo button.

Draw: Start where you want the GoTo button to appear and make two distinct circles (or ovals). The link button will appear under the center point of the gesture. The circles do not have to intersect, but you can position a button more precisely if they do. Be sure to keep the pen close to the screen until you've completed both circles.

Center point of gesture

What doesn't work: Lifting the pen tip too far from the screen; sloppy circles that overlap themselves or look like other shapes.

Figure-eights don't work

Where else it works: You can create GoTo buttons almost anywhere; eg., in stationery documents, the cork margin, tables of contents, text documents and numeric tables, and notebooks on the bookshelf.
What it does: Increases or decreases the point size of a word or text selection.

draw tip left-to-right

Draw: Use two strokes to draw an arrow; you can draw the shaft from the bottom up or the top down, and you can draw either the arrow tip or the shaft first, but be sure to make the arrow tip in one stroke from left to right. Just barely lift the pen tip before drawing the tip.

increases to next available size
increases to next available size

What doesn’t work: Arrows made with one stroke; lifting the pen tip too far between parts of the gesture; too much angle on the arrow shaft; making a loop at the arrow tip; starting the arrow tip from the right; cluttering the gesture with extra hooks or wiggles.
**UP-RIGHT**

*What it does:* Opens a single-character writing pad.

*Draw:* With one up-right stroke, beginning the gesture from the bottom (on the text line or in the middle of the line), make an upside-down capital letter L just before the place where you want to insert the character. The place where the pen tip first touches determines the insertion point.

```plaintext
insert a character
insert a character
insert a character
insert a character
```

*What doesn't work:* Not 90° (the gesture must be made at a right angle to the text line); starting the gesture too far below the text line.
<table>
<thead>
<tr>
<th>DOWN-LEFT</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What it does:</strong> Inserts a paragraph break to the immediate right of where you make the gesture.</td>
</tr>
<tr>
<td><strong>Draw:</strong> With one down-left stroke, starting at the top (within the line of text or just above it), make a backwards capital letter L (to a point just below the line of text) where you want to insert a paragraph break.</td>
</tr>
<tr>
<td>Use it to insert a break. To start a new paragraph...</td>
</tr>
<tr>
<td>Use it to insert a break. To start a new paragraph...</td>
</tr>
<tr>
<td><strong>What doesn't work:</strong> Not drawing the gesture at a right angle to the text line; making it too much like a check; starting the gesture at the bottom, or too far above the line.</td>
</tr>
<tr>
<td>Use it to insert a break. To start a new paragraph...</td>
</tr>
<tr>
<td>not a right angle</td>
</tr>
</tbody>
</table>
**DOWN-LEFT-FLICK**

**What it does:** Inserts a one-line break into text without beginning a new paragraph.

**Draw:** With one stroke, make a backwards capital letter L where you want to insert a line break, then, barely lifting the pen, make a right-to-left flick just below the horizontal line. The flick should be parallel to and about the same length as the horizontal line.

![Down-Left-Flick Gesture](image)

**What doesn't work:** Taking more than two strokes to make the gesture; making the gesture at odd angles; lifting the pen too far above the screen before making the flick; making the flick in the wrong direction.
DOWN-RIGHT-FLICK

What it does: Inserts a tab into any document.

Draw: With one stroke, make a capital letter L where you want to insert a tab, then, barely lifting the pen, make a left-to-right flick just below the horizontal line. The flick should be parallel to and about the same length as the horizontal line.

What doesn’t work: Taking more than two strokes to make the gesture; making the gesture at odd angles; lifting the pen point too far from the screen before making the flick; making the flick in the wrong direction.
<table>
<thead>
<tr>
<th>RIGHT-UP</th>
</tr>
</thead>
</table>

**What it does:** Formats text with initial caps.

**Draw:** With one stroke, horizontal then upward, make a capital letter L that's lying on its back. The horizontal line should begin on a targeted character and cross through the word(s) to be formatted and the upward line should be a 90° angle, immediately after the last character you want to format. When formatting a large selection, make the gesture anywhere within the selection.

**From All Caps To Initial Caps**

**What doesn't work:** Making the gesture in two strokes; making the gesture at odd angles; underlining the words with the horizontal line instead of drawing it through the words.
### RIGHT-UP-FLICK

**What it does:** Formats text and selected text as upper case characters.

**Draw:** With one stroke, horizontal then upward, make a capital letter L that’s lying on its back. Then, barely raising the pen, make an upward flick beside it. The horizontal line should cross through the word(s) to be formatted and the upward line should be a 90° angle, immediately after the last character you want to format. When formatting a large selection, make the gesture anywhere within the selection.

```
       ————\ /
        \    \  
       \     \  
        \     \  
       \     \  
        \     \  
       \     
```

converts to `upper—case`  
converts to UPPER CASE

**What doesn’t work:** Taking more than two strokes to make the gesture; making the gesture at odd angles; lifting the pen too much before flicking; underlining the words with the horizontal line instead of drawing it through the words; making the flick downward instead of upward, or at an odd angle.
<table>
<thead>
<tr>
<th>RIGHT-DOWN</th>
</tr>
</thead>
</table>

**What it does:** Formats text as lower case.

**Draw:** With one stroke, horizontally then downward, make a capital letter L that's face down. The horizontal line should cross through the word(s) to be formatted and the upward line should be a 90° angle, immediately after the last character you want to format.

![Diagram](image)

CONVERTS TO LOWER CASE

CONVERTS TO lower case

**What doesn't work:** Making the gesture in two strokes; making the gesture at odd angles; underlining the words with the horizontal line instead of drawing it through the words.
<table>
<thead>
<tr>
<th>CHECK-TAP</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What it does:</strong> When an embedded document's title line is hidden (where you would normally use a plain check gesture to display document options), this gesture displays options for the document.</td>
</tr>
<tr>
<td><strong>Draw:</strong> Draw the check in one gesture. Then, barely lifting the pen, make a tap just to the right of the check.</td>
</tr>
<tr>
<td><strong>What doesn't work:</strong> Drawing the checkmark at a horizontal or vertical angle; unclean (hooked) lines; tapping in the middle or beneath the check mark; lifting the pen too far before tapping.</td>
</tr>
<tr>
<td>checkmark can't be vertical</td>
</tr>
<tr>
<td>tap can't be inside check mark</td>
</tr>
<tr>
<td><strong>Where else it works:</strong> Within embedded documents, works anywhere.</td>
</tr>
</tbody>
</table>
**Proof**

*What it does:* Opens a proof sheet that includes alternative spelling choices for editing a word.

*Draw:* Anywhere within the word or selection that you want to proof, draw a capital letter P.

Proof thus word only

*What doesn't work:* Making the P so that most of the gesture is above or below the line, or drawn over a portion of a word other than the one that you want to proof.

Proof thus word only

Proof thus word only
EJECT FLOPPY

What it does: When you are using the diskviewer, this gesture ejects a floppy disk.

Draw: In diskviewer, make a capital E, just as you would write one in text. The gesture works on the disk icon and the disk label. This manner of ejection "remembers" the disk and retains an image of its icon.

What doesn't work: Trying to use this gesture anywhere except in the diskviewer; making the E differently from the way you practiced it in the Handwriting Training.
<table>
<thead>
<tr>
<th><strong>FIND</strong></th>
</tr>
</thead>
</table>

**What it does:** Opens a dialog sheet that lets you search a document or selection for a specified word.

**Draw:** Using three strokes (even if you didn’t practice Fs that way in the Handwriting Training), make an upper case F wherever you want the Find & Replace option sheet to appear; keep the pen tip close to the screen while making the gesture.

**What doesn't work:** Not using three strokes to make the gesture; lifting the pen too far before completing the gesture.
**SPELL**

*What it does:* Opens a dialog sheet that lets you check the spelling of a document (when the gesture is drawn on the title line) or selection (when the gesture is drawn anywhere within the selection). Permits the addition of unrecognized words to the dictionary.

*Draw:* To check the spelling of a selected word or sentence(s), make an uppercase S over the selection. To begin a spell check of a whole document, make the S on its title line; to begin a running spell check from within a document, make the S on the first character of the first word you want checked.

- Checks one selected word.
- Starts checking from any word.
- Checks an entire selection.

*What doesn't work:* Making the S so that most of the gesture is above or below the character line or drawn over a portion of a word other than the one you want to check, or drawn substantially outside the selection.

- Checks an entire selection.
- Too much outside the selection.
<table>
<thead>
<tr>
<th>B</th>
<th>BOLD</th>
</tr>
</thead>
</table>

**What it does:** Make text bold. In the title line of a document, the B gesture hides or shows the border that encloses the document.

**Draw:** Make an uppercase B over the word, sentence, or selected text that you want to appear as bold text.

- Bold one word.
- Bold one word.
- **Bold entire selection.**
- Bold an entire selection.

**What doesn't work:** Making the B so that most of the gesture is above or below the line, or drawn over a portion of a word other than the word that you want to format, or drawn too much outside the selection; making the B in a different way than you did in the handwriting training.
**ITALIC**

**What it does:** Makes text italics.

**Draw:** With three strokes make an uppercase I (no matter how you practiced this letter in the Handwriting Training) over the word, sentence, or selected text that you want to appear in italics.

- Italicize one word.
- Italicize one **word**.
- **Italicize an Entire selection.**
- Italicize an **entire selection.**

**What doesn't work:** Making the I so that most of the gesture is below the line, or drawn over a portion of a word other than the one that you want to italicize, or drawn too far outside the selection; failing to use three strokes to make the I gesture (a one-stroke I will be interpreted as a flick).
What it does: If you want more room on the screen for documents, you can hide the menu line by making the M gesture in the document title line; when you need them again, the M gesture in the title line re-displays the menus.

Draw: Make an uppercase M in the title line of the document.

What doesn’t work: Making the M too different from the way you practiced it in the Handwriting Training.
<table>
<thead>
<tr>
<th><strong>NORMAL</strong></th>
</tr>
</thead>
</table>

**What it does:** Formats text as normal (plain), removing such styles as bold, italic, or underline.

**Draw:** Make an uppercase N over the word, sentence, or selected text that you want to have appear in the normal format.

Changes formatted text to normal

Changes formatted text to normal

**What doesn't work:** Making the N so that most of the gesture is above or below the line, or drawn over a portion of a word other than the one that you want to format, or drawn too much outside the selection that you want to format; making the N in a different way than you did in the handwriting training.
What it does: Determines whether or not a tab shows along the edge of a notebook. When a tab is showing, the T gesture hides the tab; when a tab is hidden, the T gesture displays it.

Draw: In two strokes make an uppercase T in either the document title line or the Table of Contents title line.

What doesn't work: Crossing the T so that it looks like an X.
**UNDERLINE**

*What it does:* Underlines text.

*Draw:* Make an uppercase U over the word, sentence, or selected text that you want to appear underlined.

- Underline one word.
- Underline an entire selection.

*What doesn't work:* Making the U so that most of the gesture is above or below the line, or drawn over a portion of a word other than the one that you want to underline, or drawn too much outside the selection; making the U too much like a V.
<table>
<thead>
<tr>
<th>CORK MARGIN</th>
</tr>
</thead>
</table>

**What it does:** Shows/hides the cork margin.

**Draw:** Make an uppercase C in the title line of the document.

**What doesn't work:** Starting with a loop at the top of the C, closing it so much that it's interpreted as a circle, or otherwise distorting it.
CHAPTER 3

Using the Installer

You use the Installer to add a variety of things to your Notebook, including those things — like your handwriting profile and your personal dictionary — which make it uniquely your Notebook. Use the Installer when you want to add or deactivate (temporarily remove):

✓ applications
✓ fonts
✓ device drivers (instructions for devices such as printers, plotters, and modems)
✓ services such as network, electronic mail, and information services
✓ preferences
✓ handwriting profiles
✓ dictionaries.

When you install something, PenPoint remembers which disk (volume) you used to install the information and its location on the disk. This location is called its home volume. PenPoint refers to the home volume when you save or update something, or when you deactivate and then reactivate it.

Some software is automatically installed when you insert the floppy disk in the disk drive. In that case, you'll see an installation message. If not, then install it with the Installer.
Finding Out What's Installed in the Notebook

When you first open the Installer, it shows you what's currently installed in the Notebook. You'll see a sheet for each category such as Applications and Fonts. PenPoint lists whatever you have in the Notebook that matches that category. For example, on the Fonts Installer sheet, you'll see a list of the fonts you've installed in your Notebook.

1. Connect the PenPoint computer to a disk drive.
2. Tap the Installer icon to open it.
3. Tap the arrow in the title line to see a list of the other Installer sheets and tap to select the Fonts sheet if it's not displayed.

   Name shows which profiles are installed currently in the Notebook.

   Modified tells you if you've changed it since the last time you saved it.

   Size tells you how big it is so you can determine whether you have enough memory.

   Current shows which one is in use. Tap to select another set.

4. Tap the close corner to close the Installer.

   (screen) TOC with Installer tapped; (object) Installer turned to Fonts sheet
   figure 3-1
Installing an Application or Utility from Disk

To install something, open the Installer, turn to the sheet for the category of items you want to install, and choose Install from Disk. PenPoint opens a diskviewer for the connected disk and lists the items it finds on the disk for that category. Select one to install.

1. Connect the PenPoint computer to a disk drive
2. Tap the icon to open the Installer
3. Tap the arrow in the title line to see the list of install sheets, and tap to choose the one you want to see
4. Tap Install from Disk
5. Tap the disk icon to see its contents
6. Tap to select the item to install
7. Tap the appropriate action button

If you don't have enough room in the Notebook to add something, PenPoint displays a message to this effect. See "Managing Memory" in Chapter X, "Troubleshooting and Tips" for details.

Automatic Installation

Some disks install their software automatically. You'll see a list of the disk contents, and one item may be preselected. To install it, tap the Install button. Or tap to choose another item and install that one.

If you don't see an installation message when you insert the disk, use the Installer to add the items to the Notebook.
Creating a New Personal Profile

The first time you use Handwriting Training, you rename the basic (generic) handwriting profile so you can save it as your own. Similarly, you can create sets of preferences and dictionaries by copying the generic one or an existing one and then adding to it. For example, you might install a district sales office dictionary, create a new one based on it, and then modify it to include specific customer and contact names for your sales region.

When you choose preferences and add words to the dictionary in the Notebook, you are changing the generic sets. If you later want to create a new set based on the generic one, you may need to reset the preferences and delete unwanted words from the dictionary.

To copy a dictionary:

1. Connect the PenPoint computer to a disk drive
2. Tap the icon to open the Installer
3. Tap the arrow in the title line to see the list of install sheets, and tap Dictionary
4. Tap Create
5. Write in a name
6. Tap the name of the dictionary on which you want to base the new one
7 Tap to choose a Home Volume

The volume that’s currently selected is the home for the dictionary you chose in Start From, so if you want this dictionary to have the same home, you don’t have to change anything.

To choose a different home for the new dictionary, insert a disk or tap its volume name.

8 Tap the appropriate button

(object) Dictionary install sheet with Create tapped;
(object) Create sheet with "Sales Rep Dict" written in the name field and the home changed from the hard disk to Floppy 2

You can leave the name field blank, and PenPoint will use the name of the dictionary in the Start From field and add the number 1 to it, so Dictionary becomes Dictionary 1.
Saving Your Changes

The Installer keeps track of any modifications to things you've installed. To save these changes copy them to the home volume. If you don’t want to keep the changes, restore an earlier version by updating it from home.

1. Connect the PenPoint computer to a disk drive
2. Tap the icon to open the Installer
3. Tap the arrow in the title line to see the list of install sheets, and tap to choose the one you want to see
4. Check to see whether you've modified your choice since the last time you saved it to disk. If so you can save the changes or restore an older version.
5. Tap to select it
6. To save new changes choose Copy to Home from the Home menu
   To restore an earlier version choose Update from Home

(object) service install sheet with Dot Matrix printer showing it's been modified and Copy to Home tapped on Home menu
figure 3-4

As a shortcut, draw a {{H}} on the name of an item in the Installer to copy it to home, and a {{U}} to update it from home.

You can rename an item in the usual way, by drawing a circle on it and changing it in the editing pad. PenPoint considers renaming something a modification of it.
Deactivating Applications and Utilities

You can use the memory in your computer most efficiently by deactivating the applications, handwriting profiles, and services you're not using. Deactivating them is a way of temporarily removing them. For example, you might deactivate the applications and services you won't be using on a trip.

When you deactivate something PenPoint deletes it from the Notebook, but leaves a placeholder and remembers its home volume. You can reactivate something in one step instead of having to reinstall it completely.

1. Connect the PenPoint computer to a disk drive
2. Tap the icon to open the Installer
3. Tap the arrow in the title line to see the list of install sheets, and tap to choose the one you want to see
4. Tap to select what you want to deactivate
5. Choose Deactivate from the Home menu to remove it but leave a placeholder for it

(Make sure you've copied the most recent version to home before you deactivate anything.)

Choose Reactivate to reinstall something.

(object) application install sheet with Draw tapped and Deactivate selected from Home menu
figure 3-5

As a shortcut, draw a {{D}} on the name of the item in the Installer to deactivate it, and a {{U}} to reactivate it.

Draw a cross out {{cross out}} to delete an item. (If you delete it, you'll need to reinstall it when you're ready to use it again.)
When you deactivate or delete an application, PenPoint tells you how many documents are currently using the application. If those include the one you're working on you can quickly save any changes by turning to another page in the Notebook before you deactivate the application. To save the changes to floating documents, close them.
Changing the Home Volume

At times you may find it convenient to set a different home volume. For example, you might decide to consolidate dictionaries from different floppy disks to a single disk.

In Alpha avoid changing the home of an application or service, since PenPoint refers to data on the original home volume when it reactivates or reinstall the application or service.

1. Connect the PenPoint computer to a disk drive
2. Tap the icon to open the Installer
3. Tap the arrow in the title line to see the list of install sheets, and tap to choose the one you want to see
4. Draw a check [checkmark] on the name of the item whose home you want to change
6. Tap to select a new home volume

*(object) dictionary install sheet with check on Sales Rep Dictionary (floppy 2);
(object) option sheet with tap on hard disk

Figure 3-6

The Home Path is the directory in which PenPoint expects to find the installable file. When you change the home, PenPoint creates a directory for it on the new disk. There's no need to change the path unless, for example, the path conflicts with one you've set for a specific network configuration.

You can also get to the options sheet on which you change the home volume by tapping a name to select it and choosing Options from the Edit menu.

To change an item's home volume and copy it there in one step, open a diskviewer and move the item from the install sheet to a location on the diskviewer.
Installing Devices and Services

Before using a printer, modem, or other serial device or service, you install its driver with the Installer and then set options for it in the Device notebook.

Before using a device or service make sure you have connected the physical equipment properly. See “Setup and Care” (chapter XX). Also, consult the manual that comes with your equipment for specific settings you should use.

Connecting a Printer

When you're ready to attach a printer to the PenPoint computer, you install the printer driver and then set options for it — such as the model of the printer and the port it will use — in the Device notebook.

You only need to set up this information once. When you're ready to print, use the Printer Service option sheet to tell PenPoint you've attached the printer and then choose Print.

1. Install the printer driver with the Installer
2. Tap to open the Device notebook
3. Tap the page number to turn to the Printer page
4. Choose Add from the Edit menu
5. Write in a name for the printer
6. Tap to select the type of printer
7. Tap to select a port

*Information on selecting the Basestation or Printer port will be included in Beta jm September 30, 1990*

If you're connected to a PC or network, tap to select the printer name

8. Tap Ok to accept these settings
and tap on Printer page number;
(object) Printer page with Add selected from Edit menu and Add sheet displayed;
write in name for printer "Sales Area Laserjet"
figure 3-7

After adding the printer, PenPoint displays another set of options so you can choose the appropriate model.

1 Tap to select the name of the model of the printer you're connected to
2 Tap Ok to add the printer to the list of available printers

(object) option sheet that comes up after you tap Add with HP Laserjet selected
figure 3-8

Setting Printer Options

PenPoint lists the printer's name and type on the Printer device sheet. The setup requirements for each printer may vary, so to complete the setup information, choose the appropriate printer options. For example, on the:

✓ Service sheet, add the printer name to the list of equipment sharing the same port
✓ Serial sheet, set options for how the data will be sent, such as the flow control or baud rate (Consult the manual that comes with your equipment for these specifications.)
✓ Options sheet set options for the printer's capabilities, such as paper handling.

1 On the Printer sheet, draw a check (checkmark) on the name of the printer to display the printer option sheets
   (Or, tap to select the name of the printer and choose Options from the Edit menu)
2 Tap the arrow in the title line to display a list of option sheets and tap Service to see it
3 Tap the name of the printer you've just created
4 Tap **On** if you're currently connected to the printer or **Off** if you're not.

5 Tap the appropriate button.

*(object) Printer sheet in Device notebook with check on HP Laserjet; (object) Printer options sheet with Service sheet displayed*

**Figure 3-9**

To set the serial options:

**1** On the Printer sheet, draw a check **[checkmark]** on the name of the printer to see the option sheets.

**2** Tap the arrow in the title line to display a list of option sheets and tap Serial to see it.

PenPoint lists the serial port you've previously selected on the Add Printer sheet.

**3** Tap to see the different choices in each category, tap to choose the appropriate ones.

(Consult the manual that comes with the equipment for the appropriate setting)

**4** Tap the appropriate button.

*(object) Printer sheet in Device notebook with check on HP Laserjet; (object) Printer options sheet with Serial sheet displayed*

**Figure 3-10**

To set specific printer options:

**1** On the Printer sheet, draw a check **[checkmark]** on the name of the printer to see the option sheets.
2 Tap the arrow in the title line to display a list of option sheets and tap Options to see it

PenPoint lists the printer model and the port to which you'll attach it

3 Tap to see the different options, tap to select them

4 Tap the appropriate button

(object) Printer sheet in Device notebook with check on HP Laserjet;
(object) Printer options sheet with Options sheet displayed

figure 3-10

Printing a Document

Once you specify the settings for the printer in the Device notebook, you can save this setup information on the home volume, so you don't have to reset the options each time you deactivate the printer service.

When you're ready to print:

✔ on the Printer Service install sheet, select the name of the printer and tap Connect On to tell PenPoint you've attached the printer to the computer

✔ choose Print from the Document menu and select the printer you want to use.

If you leave the printer connected, the next time you choose Print, PenPoint will try and print the document. If you won't be connected to a printer and you want the document to go to the Outbox instead, select Connect Off on the Printer Service install sheet when you've finished printing.

The procedure for setting these options will change in Beta. jm September 29, 1990
Connecting an External Serial Device

When you're something other than a printer to the computer, you choose settings for on in the Device notebook's Port sheet. For example, you'd set the baud rate for external modems and external serial devices such as plotters there.
CHAPTER 4

Creating and Using Documents
When you install a program in your notebook, PenPoint automatically places stationery for that program in the Stationery notebook and on the table of content's Create menu.

You can think of stationery as a box of paper that never runs out. To create a new document you start at the table of contents and choose a piece of stationery from the Create menu. If you find that you routinely use a few kinds of stationery, you can modify the Create menu by changing settings in the Stationery notebook.

Most of the time when you create a new document, you'll work with a full-page document. But at times you may want to work with two documents at the same time, for example to compare information. You do this by floating one document above another. Floating a document temporarily detaches it from the notebook. When you're finished working with it, you close it and it returns to its place in the notebook.

While working on one type of document, you may want to add information using different stationery. For example you might add a drawing to a written report. You can do this embedding another piece of stationery in your document. You can also prepare documents separately and combine them later into one document.
Creating a Document

Using the Create Menu

Your GO Computer comes with some stationery already on the Create menu. To create a new document from the menu:

1. In the table of contents, tap to see the Create menu
2. Tap to choose a piece of stationery
   - PenPoint inserts the new document before the current selection.

When you create a new document, PenPoint places it at the end of the table of contents. To insert it at a specific location, tap the document title in front of which you want to add a new document, and then choose a piece of stationery.

PenPoint inserts the document where you drew the tip of the caret. To insert a new document between two documents, draw the tip in the space between the documents. To insert it in a section, align the gesture with the documents in that section.

As a shortcut, you can draw a △ on the table of contents where you want the new document to go. Penpoint displays the Create menu floating over the Table of Contents. Tap to choose a piece of stationery.
CREATING A DOCUMENT USING THE CREATE MENU

Using the Stationery Notebook

The stationery notebook holds all the stationery installed on the GO Computer. If a program has more than one kind of stationery it's listed beneath the program name. You can flip through the notebook to see the different kinds of stationery, or jump to a specific page by tapping its page number.

1. Start from the Notebook Table of Contents. Tap the Stationery notebook on the Bookshelf to open it.

2. Tap-hold on the name of the stationery you want to copy.

3. When you see the animated line surrounding the title, drag it where you want it to appear on the Notebook Table of Contents.

PenPoint inserts the new document where you lift your pen. To insert a document in a section, drag the stationery to a location within the section.
Adding Stationery to the Create Menu

You use the Stationery notebook to choose which kinds of stationery to add to the Create menu. Use the column of checkboxes under the heading "Create Menu" on the Stationery notebook's table of contents.

1. Tap the Stationery notebook icon on the Bookshelf to open it.
2. To add stationery, tap an empty box. You'll see a checkmark.
   To remove it, tap again.

If you don't see the boxes, draw an M on the title line to display the table of contents menus and select the Create Menu Box command in the Show menu to display them.
Renaming a Document

When you create a new document PenPoint gives it the name of its stationery. To give it a more useful name:

✓ use the Rename command in the table of contents menu, or
✓ edit the title on the table of contents, or
✓ edit the title on the document title line, or
✓ change the title on the document option sheet.

Changing the title in one place automatically changes it in the others. For example, if you edit the title with the Rename command, you’ll see the new title when you open the document option sheet.

1 Tap Rename from the Edit menu

2 Tap the <cross-out> button to clear the pad and write in a new title

Or, edit the title in the editing pad

(If you need more room to write, drag the right handle to widen it or the bottom handle to lengthen it)

3 Tap the OK button to see the new title in the editing pad and tap again to translate it to the page

Tap the <dismiss> button to close the pad without renaming the title
CREATING A DOCUMENT

RENAMEING A DOCUMENT

If you're working on the table of contents, you can rename a document by changing it in the editing pad. To do so, draw a circle ◯ on the title to display the editing pad, and change it there. If you're working on a document, you can rename it using the same shortcut. Draw a circle ◯ on the title line to display the editing pad, and then change it.

For more information about changing editing in pads or fields see "Editing Labels, Document Titles, and Fields" in chapter 6 (Editing and Formatting Text).
Customizing a Document

You can change the document options for different tasks. For example, if you embed a pie chart in a report, you may choose not to display the title or menu line so you see how the page will look when it's printed.

You can decide whether to:

- show the title line, menu line, scroll margin, or borders
- disable editing so that a document can't be changed
- shorten the time it takes to turn to a document
- add a cork margin where you can insert goto buttons and embedded documents.

1. Draw a check ✓ on the document title
   * You'll see the Document option sheets

2. Tap on the arrow in the title line to see the other sheets

3. Tap to select each option you want

4. Tap to apply the options to the new document and close the option sheets
CREATING A DOCUMENT
CUSTOMIZING A DOCUMENT

Each program you install on the GO Computer may add its own options to the
document option sheets or remove inappropriate ones. For example, you
wouldn’t need an Author field for the clock accessory.

You’ll find explanations for how to disable editing, get quicker access to
documents, and use the cork margin in Managing the Notebook chapter 8.
Scrolling a Document

If a document doesn't entirely fit on the screen you can use flicks to navigate within the document and bring different portions into view. You draw flicks in the body of the document to scroll the document to the beginning or end or to any point in between.

Flick up to bring this line to the top of the screen

Flick down to bring the line to the bottom of the screen

Dick --
I was fiddling around with some of my mother's old recipes the other day and I came up with several ways we might try to market eggplant, which is a good stable vegetable. It's cheap to grow and it survives well in cold storage, and various preparations of it seem to hold up well on the shelf. I think these new products might be especially popular in the Southwest and in California where they're rediscovering vegetables. Let me know what you think. -- Enrique

Eggplant dip
(We'll need a catchy name for this on babaganoush that I think will hold long-term shelf storage. It involves eggplants which we can do in bulk and then smashing them with garlic, lemon, olive oil and spices. We currently have some problems with the oil separating out to the top of the jar, which is very sure we can find a binding agent.)

Southwestern curry sauce

Flick up to bring the line to display the beginning of a document

Flick down to display the end of a document

GO CONFIDENTIAL
SEPTEMBER 26, 1990
Drawing flicks is like using the eraser on a pencil to move parts of a page closer to you. You pull the page toward you (flick down) to see what’s at the top, or push it away (flick up) to see what’s on the bottom.

The scroll margin is useful for gauging your location in the document, and for jumping to a specific location in it. You may find it easier to drag the scroll handle to go to a specific part of the document. For example, if you were on page one of a four-page report, to get to the third page, you could drag the scroll handle about three-quarters of the way down the margin.

The position of the scroll handle indicates your current location.

Drag the scroll handle to move to the middle of the document.

Or, tap here to move to the middle of the document.
DISPLAYING AND POSITIONING DOCUMENTS
SCROLLING A DOCUMENT

The scroll arrows let you move either one line at a time or in a continuous scroll:

✔ Tap the bottom arrow to see more of the page below
✔ Tap the top arrow to see more of the page at the top
✔ Press either arrow to scroll the page continuously
When you detach a page from the notebook it floats on top of the current page. It continues to float even as you move around the notebook, until you close it. When you close it, it returns to its place in the notebook.

Floating one document above another allows you to compare and work with both documents without flipping between pages.

Before floating a document you must first select the option for floating documents in the Preferences option sheets. You only need to set this option once to be able to float documents any time you use the Notebook. To set the preference for floating On:

1. Tap to open the Preferences options sheets
2. If the Misc sheet isn’t displayed, tap the arrow on the title line and choose Misc from the menu
3. Tap On
If you’re working on the table of contents and want to see what’s in a document, you can float it on the table of contents, and then close it to put it back in its place in the Notebook.

To detach and float one document above another document, double-tap the Contents tab to float the table of contents, and then double-tap the page number of the document you want to float.

If you’re working with several floating documents, and the one you want to work with next is partially hidden, tap its title line to bring it to the front.

If you float a document and then turn to its page in the notebook, you’ll see the document floating on a blank page.

Double-tap its page number

To close it, tap the close corner

You can also float a document by double-tapping its title line, tab, or GoTo button.
Moving and Resizing Floaters

In addition to documents, option sheets, and auxiliary notebooks (such as the Stationery notebook) float. If the floating object is covering information you want to work with, you can move or resize it.

To move a document or notebook, press the title line. Wait until the border of the title line darkens which tells you it's ready to be moved. Drag it to its new location.

To resize it:
- Drag the corner handle to the right to widen it; to the left to narrow it
- To expand or reduce the page area in both directions, drag here
- Drag the bottom handle down to lengthen it, or up to shorten it.

If you re-open a floating document after resizing or moving it, PenPoint displays it as you last left it.
Zooming a Document

When you want to use the entire screen area to display a document, you can zoom a floating document so that it covers the tabs and the title and menu lines, thus enabling you to work on a larger area of the document. When you shrink it, it returns to its previous size.

Before zooming a document you must first choose the zoom option in the Preferences icon. You only need to set this option once to be able to zoom documents any time you use the GO Computer. To set the zoom preference to On:

1. Tap to open the Preferences <option sheets>
2. If the Misc sheet isn't displayed, tap the arrow or name at the top to see the menu and select Misc
3. Tap On
To zoom a document, draw a flick up \( \uparrow \) on the title line. Make sure the flick begins in the title line.

- To return the page to its normal size, draw a flick down \( \downarrow \).

If you've enlarged the document and want to turn to another page, shrink it first to display the page number menu and tabs.
Embedding a New Document

Another way to work with more than one document at one time is to embed one document inside another. This creates a compound document and is most useful when, for example, you want a drawing, graph, or information from a spreadsheet to appear as part of a written report. There are two ways to create a compound document:

- create a new document within another document
- move or copy an existing document into another document.

1. Start from the document in which you want to embed another

2. Draw the embedded document gesture where you want the new document to go

   You'll see the Create menu

3. Tap to select the stationery you want to use

   PenPoint embeds a new document of the appropriate type where you drew the tip of the gesture. You can work in it in the usual ways.

   ▲ To open more of the document, tap the icon
   ▲ To close the document tap the close corner
   ▲ To delete the document, draw a cross out X on the title line if it's open or the anchor if it's closed

   (partial screen) letter with double chevron drawn below the first sentence; tap on Draw document; text editor document; (partial screen) showing letter with Draw doc embedded and leader line to anchor

   figure U4-13
Embedding an Existing Document

You may find it more convenient to work on documents separately until you’re ready to assemble them, at which point you can copy or move one document into another. Or, you may just want to put a copy of an existing document into another.

1. Start from the document in which you want to embed another

2. Double tap the Contents tab to float the table of contents

3. Move the title of the second document to the place you want to insert it in the first

Notice that the document you moved is no longer listed on the table of contents.
Setting Document Options

You set document options for an embedded document in the usual way (draw a checkmark on the document title line).

If the title line is hidden, draw a check tap anywhere on the document.

Moving an Embedded Document

You can move an embedded document to another location in the same document by dragging it to another location. Use the {{press hold}} gesture on the title line or, if it's closed, on the anchor. To move an embedded document to a different page, float the document to which you want to move it.
Floating an Embedded Document

You can decide whether to float the document on the page when it’s open, or have it stay where you inserted it. To choose these options:

1. Draw a check ✓ on the title line (or on the icon if it’s closed) to display the document option sheets.

2. If it’s not displayed, tap the arrow on the title line to see the other option sheets. Tap to select the Access option sheet.

Choose in place if you’ll usually work with the document where you inserted it.

Choose floating to see information in the embedded document while working in another part of the larger document.

If you choose floating, when you turn the page, the document stays on its page. If you choose in place, you can still float the document by double-tapping its title line. But when you turn the page, it floats on the new page.

You work with floating embedded documents in the same way you do a floating full-page document. To resize it, drag the handles, to move it press hold and then drag the title line, to close it tap the close corner. When you close it, it returns to the insertion point.
Making an Embedded Document a Full-page Document

You can reverse the procedure and split compound documents into two separate documents. For example, if you decided you didn’t need to illustrate sales results with a graph, you might want to remove the graph from the report, but keep the graph in the notebook.

To copy or move an embedded document to a separate page, press hold the title line of the embedded document (or the icon if it’s closed), turn to the table of contents, and drag the document to a location on the table of contents.

Where you lift the pen tip determines where the document goes.

- To insert the document between two documents, lift the pen in the space between the documents
- To place it in a section, lift the pen when it’s aligned with the other documents in the section
- To place it outside a section, lift the pen when it’s aligned with the left margin.
Printing an Embedded Document

When you print the larger document, only the part of an embedded document that's showing at the time gets printed. To print a portion of an embedded document within the larger one, resize it before you print. If you want to print the whole thing choose Print All Contents on the Print Setup option sheet.

Select Print All Contents to print the entire document

If an embedded document is near the end of a page, select Keep on Page to prevent the contents from being split between two pages

To make sure that an embedded document always begins on a new page, select Begin on Page

To print the embedded document without printing the document that contains it, choose Print from the embedded document's Document menu.

The larger document's Print Setup option sheets set the orientation and paper size for the embedded document and suppress other Print Setup options for the embedded document, such as margins, headers, and footers.

If you want to format the embedded document with its own margins and header and footer information, set the appropriate Print Setup options for the embedded document and then select Print All Contents. PenPoint prints the embedded document starting on a new page using the settings you've selected and then returns to the options for the document that contains it.

You'll find more details about the Print Setup options in Printing, Sending, and Receiving Documents (chapter 9).

If the embedded document is closed, it isn't printed at all. To avoid printing the icon, move the document to the cork margin. You can find out how to use the cork margin in Managing the Notebook (chapter 8.)
Creating Stationery

You can use the stationery from the Stationery notebook as it is set up, or you can change the margins, the font and other options. If you routinely change options you can customize a piece of stationery and add it to the Stationery notebook. For example, you might create stationery for a weekly report that would have preset margins and an embedded spreadsheet.

To set text options, such as the font for a document, write text on the page and then style and format it appropriately.
Creating Customized Stationery

1. Tap to open the Stationery notebook, which is where you'll create the new piece of stationery.

2. Select a location in the Stationery notebook table of contents for the new document.

3. Tap to open the Create menu and tap the stationery you want to customize.
   (If you don’t see the table of contents menus, draw an M on the title line to display the menus.)
   ▲ A piece of stationery is added to the stationery notebook.

4. Name the new stationery in the usual way.

5. Turn to the new document in the Stationery notebook.

6. Draw a ✓ on the title line and select the options you want included in the customized stationery.

Once you've created stationery, you can further modify it by turning to it in the Stationery notebook and making the necessary changes there.
Managing the Stationery notebook

You manage the Stationery notebook from its table of contents just as you do the basic Notebook. You can rearrange the stationery titles, group related ones together, rename them, and delete the ones you no longer need. (If you don't see the table of contents menus, draw an M on the title line to display the menus.)

To rearrange the order:
✓ press drag to move a piece of stationery to another location

To group stationery into sections:
✓ Select a location on the table of contents
✓ Choose Create Section from the Create menu
✓ .. to expand the section
✓ Press drag to move a document where it says “Empty”

To attach a tab:
✓ Choose Tab from the Show menu and tap the checkbox next to the title

To rename stationery:
✓ Draw a ○ over the title to display the editing pad and change the title.

To delete stationery:
✓ Draw a × over the title

You can find more detailed instructions for these procedures in “Managing the Notebook” (chapter 7).
MOVING AND DELETING DOCUMENTS

To manage your notebook efficiently you can remove documents you no longer need. If you want to use a document at some future date, move it to a floppy or hard disk instead of deleting it. If you know you’ll never use it again, you can delete it.

To delete a document:

✓ Draw a × on the title in the table of contents or the document title line

✓ Or, select the document in the table of contents and choose Delete from the Edit menu.

Before deleting a document, decide whether or not you want to keep a backup version of it on disk. You can find out how to make backup versions in Filing (chapter 10).

When you delete a document, PenPoint asks you whether or not you want to delete the document. To go ahead, tap Delete. To change your mind, tap Cancel.

object screen of the delete confirmation message  figure U4-18
Writing in the Notebook
You write in the notebook on a writing pad as you would on a paper pad. When you're done, the Lombard converts what you've written into typed, electronic text which you can then easily correct and edit.

Writing pads vary in size to accommodate different writing tasks. Some pads are already on the page when you create a new document. For example, a writing pad automatically appears on newly created Text Editor documents. Others, such as the line pad, pop up when you want them.

### Printing in the Writing Pad

Writing pads contain separate boxes for each character. After translation the characters remain in their boxes so you can correct them before you translate your printing to the page.

<table>
<thead>
<tr>
<th>TextEdit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
</tr>
<tr>
<td>Our company specializes in condiments and prepared foods. The discriminating customer is</td>
</tr>
</tbody>
</table>

Start the letter in the character box and print clearly

Write naturally; the Lombard will keep up with you

Leave a space between words (if you finish a word in the last character box, skip a box on the next line before starting the next word)

You can cross your t's and dot your i's after writing a line and before starting a new one

Draw a scratch out when you want to erase something you've written

To start a new paragraph, leave a space between lines

If you normally print in upper case, open the Preferences option sheet and choose the All Caps option from the Handwriting option sheet.
When you print a descending letter such as a “g”, it goes into the box below it. You can write in this box when you get to it.

If you can’t fit a word at the end of the line, don’t hyphenate it or PenPoint will translate the hyphen. Scratch it out and write it on the next line. PenPoint translates the extra spaces you leave at the end of the line into a single space.

Sometimes when writing you’ll make the first letter of a word larger than the others. You’ll get more accurate results if you make the upper and lowercase letters a consistent size.

<Handwriting Appendix> offers further tips on handwriting.

At some point you may find it easier to write on ruled pads or to use a keyboard to enter text. To learn how to use a keyboard and adjust the style, size, and shape of the pads, read “Using Writing Pads” in this chapter.
At any time you can translate your printing in the writing pad. This allows you to see whether the letters are correct before you tell PenPoint to translate them to the page.

To get the best translation results:

- Align the pen with the Pen sheet of the Preferences notebook.
- Review the handwriting tips in <Handwriting Appendix>
- Train PenPoint some more with Handwriting Training which you’ll find in the Accessories notebook.

The single character pad translates your handwriting automatically when you lift the pen away from the screen.
Correcting the Translation

If the Lombard mistranslates a word, you can correct it in the writing pad before you transfer what you've written to the page. Or, you can wait and correct it later on the page with the proof sheet or with editing gestures.

Correcting the Translation in the Writing Pad

If PenPoint doesn't recognize a letter, it replaces the letter with a {circle questionmark}. To correct unrecognized or mistranslated letters:

- Write over a mistranslated letter
- Or, use gestures to correct it.

When you draw a gesture, begin it within the character box and end it outside the box. Otherwise, the Lombard will try to interpret your gesture as a letter.

- Insert a space with the L. The size of the space depends on the length of the bottom of the gesture.
- Draw a vertical pigtail to delete unwanted characters
- Draw a horizontal line through the letters you want to delete
CORRECTING THE TRANSLATION

Correcting the Translation with the Proof Sheet

If you need to correct a word on the page, you can often find the correct word on the Proof sheet.

1. Draw a P over the incorrect word to display the proof sheet.
2. Tap to select the correct word from the list of suggested alternatives.
3. If one of the alternatives is close to the word you want, double tap ... the word to put it in the editing pad and display a list of further alternatives.

Or, edit the characters in the editing pad.
- Write over a mistranslated letter.
- Or, use the same gestures you use to correct the text in the writing pad.

4. Tap to translate the text in the pad and tap again to replace the incorrect word with the corrected one.

The list of alternatives may include combinations of letters PenPoint doesn’t recognize as a word, since the word you wrote may be an acronym or personal noun not found in its dictionary. Selecting it on the Proof sheet adds it to the personal dictionary so that the next time you write the word, PenPoint will translate it correctly.

It’s sometimes easier to correct the translation directly on the page, particularly when only one or two characters are mistranslated. You can read about editing gestures that let you correct and revise the text in “Editing and Formatting Text” (chapter 6).
Using Writing Pads

Getting a Writing Pad

To get a character pad, draw a insert character I

To get a line pad, draw a caret A

- To increase the writing area, drag the handle to the right to widen the pad, down to lengthen it. Do the opposite to decrease the writing area.

- Tap anywhere outside a character or line pad to dismiss it without translating what you've written.

To get a paragraph pad, draw a caret tap A

- Drag the handle down to expand the writing area.

- To close it, tap the translate button if it's empty (if it's not, draw an X on the translate button to clear it).

If you are working in a Text Editor document, you can insert writing pads by selecting the appropriate pad from the Insert menu.
USING WRITING PADS

Some pads don't have translate buttons or resize handles. They're designed for the specific task, such as adding a single character or writing text in a field.

When you want to add several words to a document use the line pad. Insert a paragraph pad to add several sentences. The paragraph pad begins where you draw the gesture and stays open so you can continue using it. When you need more room to write, drag the bottom handle down.
Choosing a Writing Pad Style

Once you get used to writing in the notebook, you may find it more convenient to write on a ruled pad. Ruled pads differ from character box pads:

✓ PenPoint doesn't translate the writing in the pad before transferring it to the page. You correct what you've written by drawing a <scratch out> gesture.

✓ The pad is only intended for handwriting. (If you'd rather enter text with the keyboard, you can do so in the document.)

1 Tap Preferences to open it and tap Ruled on the Handwriting Sheet

2 Write naturally. Leave space between words or draw a <??> to insert a blank space.
   ▲ Draw a scratch out Ð to erase what you've written
   ▲ Draw a cross out X on the translate button to clear the pad

3 Tap the translation button to transfer your writing to the page
USING WRITING PADS

If in translating your printing to the page, PenPoint doesn't recognize a letter, it replaces the letter with a {{circle questionmark}}. You can correct mistranslated words with editing gestures or the Proof sheet. You can find out how to correct words in the Proof sheet in this chapter and an explanation of how to edit text in "Editing and Formatting Text" (chapter 6).

When writing on the ruled pads, you can get the best translation results, if you:

✓ write as neatly as you do in the character boxes
✓ leave a consistent amount of space between characters and words (leave more space between words than you do between characters)
✓ make your uppercase and ascending letters ("h", "d") a consistent height and your lowercase letters ("a", "t", "c") a consistent size
✓ write vertically rather than on a slant. PenPoint sometimes translates overlapping letters as one letter.
✓ connect the strokes that you make to form a letter, such as a "t" or "k". Otherwise, PenPoint may translate each stroke as a separate character.

The <Handwriting Appendix> offers further tips on handwriting.

You can adjust the shape, size, and spacing for either ruled or character box styles. Change the style on the Handwriting sheet of the Preferences notebook.
USING WRITING PADS

Using a Keyboard to Write

At times you may find it easier to type in the writing pad instead of printing in it. You can use PenPoint's software keyboard or a regular keyboard that you plug into the GO QuickCharger.

To use the software keyboard:

1. Tap the keyboard icon (if the keyboard icon is not visible, open Accessories notebook and tap the keyboard icon)

2. Tap a character on the keyboard

   PenPoint inserts it in the first character box

   ▲ To type an upper case letter, tap the shift key and then the character you want. Tap the shift key again to return to lower case.

   ▲ To change a translated character in the writing pad, tap the character box to make it active, then tap the appropriate key on the keyboard

3. To move the keyboard, press and drag the title line

4. Tap to close the keyboard

When you use the keyboard to insert text in a writing pad, field, or on the page, you first tell PenPoint where to begin typing.

In a writing pad the current character box is highlighted. To select another location, press hold a different character box. When you start typing, PenPoint replaces the contents of the character box. If you continue typing, it replaces the contents of the next boxes as well.

To tell PenPoint where to begin typing in a field, press hold the space between letters. On a page, tap the space between letters.
USING WRITING PADS

Depending on your writing task, you may want to choose a different keyboard layout. Draw a check on the title of the current keyboard and tap to select an alphabetical or PC compatible layout or a numeric keypad.

To use a regular keyboard, plug it into the QuickCharger and follow the same procedure for typing in a writing pad as you do for the software keyboard. You can find a diagram for how to attach the keyboard in “Setup and Care” (chapter <??>).

PenPoint doesn't use the function, {Alt}, and {Ctrl} keys on the keyboard.
Training the Lombard in Your Handwriting
CHAPTER 6

Editing and Formatting Text
EDITING TEXT

Selecting Text

Sometimes the object of your commands is obvious. For example, to delete a single word you draw a cross out \( \times \) over it. At other times, you need to tell PenPoint what to act upon by first selecting it. For example, to delete a whole paragraph, you first need to select it.

To select a whole unit of text press hold a character to select it

Double tap to select a word

Triple tap to select a sentence

Quadruple tap to select a paragraph

To select the entire document, choose Select All from the Edit menu

You can specify how much text is selected with two other gestures.

Press and drag to select the text from the first character you touch to wherever you lift the pen

Or, draw brackets [ ] to select enclosed text

\textbullet{} Redraw (left bracket) [ to adjust the selection

When you first draw the brackets or later redraw them to expand the size of the selection, PenPoint selects the text by whole words. If you redraw the bracket to make the size of the selection smaller, you can draw the bracket in the middle of a word. This is useful, for example, when you want to select text without the punctuation that follows it, such as a colon or period.
Editing Text within a Document

Adding Text

To add text to a document, you use a writing pad. You have a choice of three sizes of pads: single character, line, or paragraph. Choose the one that best fits the amount of text you want to add.

To add one character, draw a insert character Γ

PenPoint translates your writing when you lift the pen away from the screen.

To insert several words, draw a caret ∧

If you need more room to write, drag the handle to the right to widen it or the bottom handle down to add more lines.

To insert several lines of text, draw a caret tap Â

Tap the translate button to translate your writing in the pad, tap again to transfer it to the page.

PenPoint inserts the text where you drew the gesture to get the pad.

The paragraph pad stays on the page so that you can continue adding more text. When you’re finished using it, tap the translate button. (If you want to close it without translating what you’ve printed, first clear the pad by drawing a cross out X on the translate button, and then tap the translate button.)

To make a new paragraph, leave a blank line at the top of the writing pad.
EDITING TEXT WITHIN A DOCUMENT

Deleting Text

The delete gestures operate directly on a word or a selection. You can use them to delete text in a document and in a field.

- Draw a cross out \( \times \) to delete what's beneath the gesture
- Draw a vertical pigtail \( \uparrow \) to delete a single character
- Draw a horizontal pigtail \( \rightarrow \) to delete one or more words on a line

Show paragraph of text with following deletions:
Use last para of letter (Can you help us design a lightweight... add a "c" in front of lightweight and the word "to" before the word "design"): cross out through "to", vertical pigtail through "c", horizontal pigtail through "recyclable 8 oz"
figure U6-4

Inserting Spaces in Translated Text

To add a single space, draw a insert space \( \text{L} \)
Repeat this gesture to add more space.

Show first sentence of contract with no space between "a" and "new".
figure U6-5
Editing Text in Editing Pads

Once you've translated the text, you can change the text on the page, correct or replace the word in an editing pad. Use the editing pad when only a few characters need to be corrected. Replace the text when it's easier to rewrite it than edit it or when you want to substitute the text with new text.

To edit a word:

1. Draw a circle to put the word in the editing pad.

2. To edit it:
   - Write the correct letters over the incorrect ones.
   - Delete an individual character by drawing a vertical pigtail.
   - Insert one or more spaces by drawing insert space.
   - Delete several characters by drawing a horizontal line through them.

3. Tap the translate button to translate your printing in the pad, tap again to transfer it to the page.

Series of editing pads showing gesture (results not necessary)
Use: “It's cheap to grow and it survives well in cld sforaae, and various preparations of it seem to hold up well on the snelt” from memo:
1. Circle drawn over “snelt” with “h” overwriting the “n” and “t” overwriting the “t.”
2. Show “clde” in pad with vertical pigtail over “0,” insert space on the “l.”
3. Show “sforaae” in pad with horizontal line from “f” through second “a.”

Figure U6-6
EDITING TEXT
EDITING TEXT IN EDITING PADS

To replace a word:

1. Draw the replace gesture over the word to display an empty editing pad.
2. Write in the new word and tap the translate button.

PenPoint replaces the word with the new one.

series of editing pads showing gesture results not necessary
Use: “It’s cheap to grow and it survives well in cold searae, and various preparations of it seem to hold up well on the snelt” from memo:
circle-line over “survives” and “keeps” written in pad
figure U6-7

The size of the circle you draw determines the amount of text that PenPoint places in the editing pad. You can draw the circle over a word, or several words.

Resize the editing pad by dragging the lower right-hand handle when you want more character boxes to write in. (Resizing is explained earlier in this chapter.)
Use an editing pad to change what you've written on:

- tab, icon, and GoTo button labels
- document and section titles in the table of contents
- titles in the document title line
- Forms, option sheets, and lists, such as the {Send List}

1. Draw a circle to put the text in the editing pad

2. To edit it:
   - Clear the pad by tapping the \{x button\} and then write in the new text
   - Write the correct letters over the incorrect ones
   - Or edit the text with:
     - a vertical pigtail \(\uparrow\) to delete a single character
     - a horizontal line — to delete a series of letters
     - \(\text{l}\) to insert space

3. Tap the \{OK button\} to translate your printing in the pad; tap it again to replace the text on the label or field

- To dismiss the editing pad without translating your printing, tap the \{circle slash button\}

series of editing pads showing gesture (results not necessary):
- show \(\Theta\) over "New Uses for Eggplant" in table of contents
- circle over Eggplant; word in editing pad and leader line to delete button
- empty pad with the word printed "squash"
- figure U6-8
Editing Fields

Generally, you'll enter and change text more often in fields than you do for labels and document titles. There are several gestures you can use to quickly change the text.

To delete the contents of the field, cross out X or scratch out = the text.

To add text, draw a caret △.

To use the keyboard to add text, first press hold to tell PenPoint where to enter the text, then type in the text.

Write the correct number over the incorrect one.

Draw a circle ○ to put the text in an editing pad and edit the word using the vertical pigtail △, horizontal line —, and insert space gesture L.

(screen) order form (example will be a change of address for the company.
scratch out through Address; overwriting new zip code; caret on Name and "& Weber" added to name;
minor misspelling in contact name to show vertical pigtail and insert space
gesture 6-8a

To quickly display an editing pad for a field, tap its text.
You can move or copy text within a document or to another document by using gestures. For example, you can move a sentence or paragraph earlier in your document, or copy a phrase that you want to repeat several times.

Moving or Copying Text

1. Select the text you want to move
2. Press your pen on the selection and hold it there until you see an animated line surrounding an icon which shows the text (or a portion of it, if the selection is longer than a few words)
3. Drag the icon to a location in the document

To cancel a move or copy, tap anywhere on the page before dragging the text.

You copy text almost the same way. Select the text, then tap it, touch the pen to the screen again and hold it until you see the icon. Then drag the copy to its new location.

If you find it easier to use the menu commands, select the text, choose Copy from the Edit menu, and then drag it where you want it to go.
Styling Text

You can change the appearance of text by using gestures or the text option sheets to: change the text style to bold, italics, or underlined; choose a different font (the typeface); and turn upper case words into lower case.

Styling Text Directly

You use gestures to style text directly on the page. If you select a range of text, the gesture applies to the selection; otherwise, it applies to the word that lies beneath it.

To style text directly, draw:

B to bold the text
I to italicize it
U to underline the text
N restores the text to its normal settings by removing the bold type, italics, and underlining

To increase the size of the characters (in points) to the next point size listed on the font option menu, draw an arrow up ↑

To decrease the size of the characters to the next point size listed on the font option menu, draw an arrow down ↓

To change the text to upper case, draw a ⇧

To convert the text to lower case, draw a ⇦

To change the text to initial capitals, draw a ⇩

3 column table: callout, "Southwestern curry sauce", result. The same word should be shown with each gesture drawn on it and the result to its right

In Text Editor documents, you can also change the case by selecting the text and then choosing the appropriate case from the Case menu.
Styling Text with Text Option Sheets

When you want to make several changes to a document or a range of text, you might find it more convenient to use the Character option sheet.

1. Select the text to style and draw a check ✓ over the selection.

2. Tap the arrow in the title line and tap to display the Character option sheet if it's not already displayed.

3. Tap to select an option.
   - Some options present several further choices. These appear on pop-up menus.

4. Tap the appropriate action button when you're done, or tap here to close the sheet without making any changes.

(screen) character option sheet popped up over Southwestern curry sauce paragraph, with Southwestern curry sauce selected with small caps and underline selected

figure U6-11

You can also display the text option sheets by selecting text and choosing Options from the Edit menu.
You can change the placement of text on the page by giving it paragraph formats.

By using gestures or the text option sheets you can:

✓ set margins for the document
✓ insert tabs
✓ show information, such as the symbols which indicate a new paragraph

You'll find information about inserting new lines, new paragraphs, and spaces between words later in this chapter in "Inserting Spaces" and "Starting New Lines, Paragraphs, and Pages."

### Setting Margins

1. Select the text to format and draw a check ✓ over the selection.
2. Tap the arrow in the title line and tap to display the Paragraph option sheet if it's not already displayed.
3. Write in the amount in inches the text should be indented from the page margin.
4. Tap the appropriate action button when you're done.

![Figure U6-12](screen contract) with items 1-5 selected; paragraph option sheet floating; with 1.25 written in left and right margin to create indented paragraphs.

The page margins are set with the Print Setup command.
Changing Line Spacing

1. Select the text to format and draw a check ✓ over the selection.

2. Tap the arrow on the title line and tap to display the Paragraph option sheet if it's not already displayed.

3. Increase the line height when you have several fonts on a line and want more space around the letters.

   - Change the spacing between lines by writing an amount in inches.
   - Indent the first line of each paragraph by writing an amount in inches for the 1st Line Offset.
   - Change the spacing between paragraphs by adding space before the first line of the paragraph or after the last line.

4. Tap the appropriate action button when you're done.

You might want to change the line spacing offset an embedded document on a page or to add space to a line if the font you've chosen looks crowded.

Positioning the Text

If you want the text to line up evenly on the right hand margin:

- ✓ display the Paragraph sheet of the Text Option sheets
- ✓ select Yes for the Justify option.

To change the placement of text on the page, select the appropriate Alignment option on the Paragraph option sheet. For example, you might select Center to place a title in the middle of a page.
Setting Tabs

1. Select the text and draw a check ✓ over the selection.

2. Tap the title line and tap to display the Tab option sheet if it's not already displayed.

3. Write a number in inches for each tab stop.
   - Draw a cross out X to delete a tab stop.
   - Draw a caret ▲ to insert a new tab stop.
   - To change the current tab, write in a new number.

4. Tap the appropriate action button when you're done.

(screen contract) items selected

(1.00 written in for 1st tab stop and 1.5 written in for second tab stop)

(show result of items indented and numbers and text aligned (insert tab gesture on 1st item to show how to insert the tab on the page))

figure U6-14

To insert a tab on a page, draw an insert tab gesture ＼ before the text you want to indent. PenPoint sets the tab stops based on the amounts you entered in the tab option sheet.
Starting a New Line, Paragraph, or Page

When you start a new line, PenPoint moves to the beginning of the next line. Use this gesture to add blank lines or to split an item on a list into two items.

When you start a new paragraph, PenPoint applies the paragraph formatting options, such as the amount if any to indent the first line and the amount of space to leave between paragraphs.

To make a new paragraph, draw an insert paragraph gesture ↓

To insert a new line, draw an insert new line gesture ↓

Show last para of letter "Can you help us..." with a down-left drawn before "I'll be travelling..."
Show client address on letter with no space between the company name and street address and a down-left-flick gesture to split line;
figure U6-14a

In Text Editor documents, you can also start a new line or paragraph by tapping to select a location, and then choosing the appropriate command from the Insert menu.

To insert a page break on a Text Editor document:

- tap to set the insertion point
- tap to select the Page Break command on the Insert menu

Copying a Format or Style

Sometimes you'll want to apply the same format or style to a different selection. For example, in a drawing of a floorplan you might want to change the pen width and fill pattern you're using for windows to match the one you used on a previous drawing. To do this:

- select the object which has the format or style you want to copy
- draw a check ✓ to display its option sheet
- select the text or object to which you'll apply the same settings
- tap Apply
Viewing Text

The View options display information on screen to tell you more about what's on the page.

You get to the View option sheet in the usual way: select a range of text, draw a check ✓, tap the name of the option sheet, and then tap to select the appropriate one.

- Shows symbols on the screen, such as paragraph marks
- Shows text that you hid with the Hidden option on the character option sheet

object: contract with hidden text added "Send J. Stanton's team a copy" at the top. Make sure there are tabs between the number and the text, eg. tab between period and "Y" (1. You agree...)
all options should be selected and results shown
figure U6-15

To add notes or comments to a document which you don’t want to show or to print, select the text and choose Hidden from the Character option sheet. To view or print this text, choose Hidden Text from the Access option sheet.

Magnifying the Text

You can increase the size of the text by magnifying it. When you magnify text it makes the letters bigger without increasing the font size.

To magnify text:
✓ draw a ✓ on a word to display the text option sheets
✓ tap the option name to display the View sheet if it's not displayed
✓ tap to see the different magnification amounts and tap to select a magnification size.
Before printing a document, you may want to know what it will look like when it’s printed. To do so:

Choose For Printer to see how the page will look when it’s printed.

(If you’ve set margins that are wider than the GO Computer screen, scroll to see the part of the document that’s off the screen.)

Choose For Screen to see the page as it usually appears on the screen.
Checking Your Spelling

You can check the spelling of anything you've written in the notebook. For example, in a document you can check the spelling of a single word, selected text, or the entire document.

When you check the spelling of a document or selection, the spell dialog shows each misspelled word in an editing pad. If you don't find the correct word among the alternatives, you can correct it in the editing pad using the editing gestures described in “Editing Text in Editing Pads” in this chapter. Or, you can write a new word over the old one.

1. To check the spelling of an entire document, draw an S on the title line.
   
   To check just a word or part of a document, select the text and draw an S over it.
   
   PenPoint displays the Spell dialog and puts the first misspelled word it finds in the editing pad.

2. Tap on an alternate word to correct it and continue checking.
   
   Or, edit the word in the editing pad using the vertical pigtail ↘, horizontal line —, and insert space gesture L.
   
   Tap to correct it on the page and continue checking.

3. At any time you can tap . to close the spelling checker.
You can start at any point in the document to check the spelling by drawing an S.

Instead of using the gesture to begin checking your spelling, you can also choose Spell from the Edit menu to check the entire document.

While you’re using the spelling checker, you can display other alternatives and skip words.

- Double-tap to put any alternative word in the editing pad and to display further alternatives.
- Tap the translate button to skip a word without correcting it and continue checking.

Adding a Word to the Dictionary

PenPoint refers to {Proximity dictionary} when it translates your writing and checks your spelling. You can add words to a personal dictionary, such as company names or acronyms, so that PenPoint will recognize them. You add words to the personal dictionary from the spelling checker, proof sheet, or by writing them in the personal dictionary which is stored in the Accessories palette.

You add words automatically to the personal dictionary each time you tap the translate button on the proof sheet or spelling checker to accept the word.

To see the words you’ve added to the dictionary, open the personal dictionary in the Accessories icon. You can add to, delete, or edit the words in the dictionary.

1. Tap to open the Accessories icon
2. Tap to open the personal dictionary
3. To view the list of words, flick the page or tap the scroll arrows
4. To add a new word draw a caret and write in the new word
   Delete a word by drawing a cross out over it
   To edit words, draw a circle to open an editing pad and change it there

Read "Editing Text in Editing Pads" in this chapter to find out how to revise text in the editing pad.
In many kinds of documents you can add a signature to your correspondence with the signature pad. Whatever you write on this pad appears untranslated, as if you had written it directly on the page. You'll need a graphics printer to be able to print your signature.

1 To add a signature to a Text Editor document, tap to select a location in the document

2 Choose Signature Pad from the Insert menu

Write your signature naturally, in whatever style you normally use

To erase what you've written, scratch it out ❌

Move the pad by ⬇️

Resize the pad by dragging the handle ⬇️

To delete a signature, select the space above and below the pad and choose Delete from the Edit menu

Once you've added a signature to a document you can fax it or print it with a graphics printer.
CHAPTER 7

Finding and Replacing Text
**FINDING AND REPLACING TEXT**

**Finding Text**

**PenPoint** can find a certain word or phrase every time it appears in a document. If you wish it will also replace it with different text.

Although you can limit the scope of a search, most often you'll probably want to search one entire document.

1. To search the whole document, draw an F on the title line
   
   You'll see the Find sheet

2. Write in the text you want PenPoint to find.

   If it's filled in from the last time you searched the document, delete the text by drawing a cross out X on it and write in the new text, or edit the text that's there

3. Tap Find to find the next occurrence of the text. Repeat this procedure until the message in the Status line tells you that the search is completed

4. At any point you can tap Close to close the sheet and end the search

You can also search a document by choosing Find from the Edit menu.

If PenPoint can't find the text you've indicated, you'll see the message End of Document Reached in the Status field.
Use the Find & Replace sheet when you want to replace the text you find with other text.

At times you'll want to stop at each occurrence to decide whether to replace it. For example, if you're replacing a word with another one, you might want to check the usage in each sentence to make sure it's correct. In this case you'll tap Find and then Replace each time.

If you want to replace all occurrences of a word automatically throughout the document, tap Replace All. For example, if you're revising a contract for a new client, you can substitute the current client's name for the old one.

1. To search the whole document, choose Find from the Edit menu.

   You'll see the Find sheet.

2. Tap the arrow on the title line to see the menu for the Find & Replace sheet. Tap to display it.
3 Write in the text you want PenPoint to find in the Find field.

Write in the replacement text in the Replace field.

4 Tap Find to locate the first occurrence of the text.

6 Tap Replace if you want to insert the new text.

Or, tap Replace All to replace every occurrence automatically.

If you don’t want to insert the text, tap Find to locate the next occurrence.

7 Tap Find to continue the search.

8 Repeat this procedure until the message in the Status line tells you that the search is completed.

9 Tap Close to close the sheet.

If the text in either the Find or Replace fields is filled in from the last time, delete the text by drawing a cross out X on it and write in the new text, or draw a circle O over the text to open an editing pad and change it there. “Editing Text in Labels, Document Titles, and Fields” in chapter 6 explains how to edit text in fields.
FINDING AND REPLACING INFORMATION

Defining the Search

The search options on the Find & Replace sheet set the extent and direction of the search and the attributes to look for, such as whole words or words whose case matches exactly.

Setting the Search Range

You can determine the range of the search in several ways. Each time you choose Find, PenPoint searches throughout the document and all the embedded documents.

✓ To search a document from any point in the document, draw a F in the body of the document. PenPoint searches from the place you drew the gesture to the end of the document. To continue the search at the beginning of the document, tap Find again.

✓ To search a document without its embedded documents, tap Document Only in the Search options.

✓ To search a selection, select the text and draw an F over it.

Setting the Position and Direction

In addition to telling PenPoint where to look, you can set the starting point and direction of the search. For example, if you’re at the end of a long document and the text you want to find is in the last two pages, you can instruct PenPoint to search from your current location backwards.
Finding and Replacing Information
Defining the Search

<table>
<thead>
<tr>
<th>Find:</th>
<th>FastPak Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match:</td>
<td>Same case only</td>
</tr>
<tr>
<td></td>
<td>Complete word only</td>
</tr>
<tr>
<td>Replace:</td>
<td>Health Food Packaging</td>
</tr>
<tr>
<td>Use case of:</td>
<td>➡️ Replacement word</td>
</tr>
<tr>
<td>Depth:</td>
<td>➡️ All Embeddies</td>
</tr>
<tr>
<td>Direction:</td>
<td>● Forward</td>
</tr>
<tr>
<td>Position:</td>
<td>Beginning of last match</td>
</tr>
<tr>
<td>Status:</td>
<td></td>
</tr>
</tbody>
</table>

To search from the current selection to the end of the document, tap Direction options and choose Forward.

To search from the current selection to the beginning of the document, tap Direction options and choose Backward.

Wasn’t implemented at time of capture.

To start the search at the last place PenPoint found the text, tap Start From options and choose Last Match.

To start the search at the top of the document, tap Start From options and choose Beginning.
Refining the Search

PenPoint gives you several other ways to refine the search. For example, you can tell PenPoint to locate only those instances where the text forms a complete word. This is helpful when you want to find a word such as “pen” without stopping for words such as “depend” and “peninsula.”
CHAPTER 8

Managing the Notebook
The Table of Contents lists all the documents in your Notebook and lets you organize them in relation to each other. You can find out more about them with the Table of Contents menus, such as the Show menu which tells you the document's size and when you last modified it.

You can also organize the Notebook to suit your work habits by moving pages from one location to another and by placing related documents in sections. To further customize the Notebook, you can set preferences, such as the shape and width of the character boxes in writing pads.

When you use the Notebook you'll often work with more than one document at a time. There are several ways to do this. Each method offers its own advantages.

- The Table of Contents shows all the documents in the Notebook organized by section, which makes it easy to identify and turn to the one you want
- Notebook tabs let you use a single tap to turn to a page from anywhere in the notebook
- Page arrows in the title line navigate quickly from one page to another
- GoTo buttons let you move directly from one document to another location within the same or different document.
The Table of Contents lists all the documents and sections for the entire Notebook in the order in which they appear. Page numbers refer to the page in the Notebook where you can find the document.

Document titles appear in plain text

Sections appear in bold

Double-tap a section title to display its contents. Double-tap again to hide the document titles.

Icons tell you the type of document you're using

Tap a section's page number to turn to its table of contents

Instead of tapping a section title to see what's in it, you can choose Expand from the View menu to display the titles. Choose Collapse to hide them.

Each section also has its own table of contents which works exactly like the one for the notebook.
Finding Out More About a Document

The document option sheets and the Table of Contents Show menu give you two tools for getting more information about a document, such as its size, the date on which you created it, and the program with which you created it. The Show menu shows you basic information about all the documents at once, whereas the document options sheets give you more detailed information about an individual document.

Using the Show menu

1 Tap to display the Show menu

2 Tap each kind of information you want to see; tap again to hide it

   Tap Tab Box to display the column of tab boxes (tap to add or remove a tab)

   Tap Icon to show the program icon

   Tap Type to see the program name

   Tap Date to find out the date on which you last modified the document

   Tap Size to tell how large the document is in kilobytes (a kilobyte contains approximately 250 words)

Partial screen of Show menu; screen of TOC with all options shown on TOC and callouts from Show menu commands to each appropriate column. figure U8-2
Using the Document Option Sheets

The document option sheets supplement the information in Table of Contents. Refer to them to see information such as the size of the document when it’s active and to change such information as the page display.

1. Turn to the document
2. Draw a check ✓ on the title line
3. Tap the arrow on the title line to see the other option sheets and make changes if necessary

The Access sheet determines what areas of the page PenPoint displays. This is also where you protect the document from being accidentally deleted or edited. A Hot Mode option lets you speed up the time it takes to turn to a document.

Use the Document sheet to enter information about the document and to find out when you created or last changed it. You can also find out how much space the document occupies in the Notebook when you’re not using it (Filed Size) and how much memory it takes up when you’re working with it (Active Size).

Refer to the Program sheet for information such as the version of the program you’re using.

You can also open the document option sheets by choosing About from the Document menu. (Choosing About from the Table of Contents displays the option sheet for the Table of Contents.)
Printing the Table of Contents

Sometimes it's useful to have a list of the documents you keep in your Notebook. You can do this by choosing Print from the Document menu and printing the Table of Contents.

Before choosing Print, check to see if you've selected a document. If so, tap it to deselect it or PenPoint will print the selected document rather than the list of titles.
Commands in the Sort menu let you rearrange the Table of Contents by criteria similar to the Show menu. Use the sort commands, for example, when you want to list documents in order of size so you can decide which ones to store outside of your notebook.

Tap the Sort menu, then tap:

- **By Page** to display the documents in the order they appear in the notebook (the default order unless you change it)
- **By Type** to group the documents by program
- **By Size** to arrange the documents according to the amount of space they occupy in your Notebook
- **By Name** to list the documents alphabetically
- **By Date** to put the documents in order by the date you last modified them

TOC sorted by size with Sort menu showing and size checked. figure U8-4

Sorting documents rearranges their order in the Table of Contents, but not their page location in the notebook.
You can rearrange the notebook by moving pages and placing related documents in sections. Rearranging pages changes their physical location in the notebook.

Moving Pages

The easiest way to move pages from one place to another in the notebook is by using the Table of Contents.

1. Tap to turn to the Table of Contents
2. Press and hold to select a document or section and then drag it where you want it to go.
   PenPoint inserts the new document where you lift your pen.

screen TOC with Section titled New Bottle Design moved so it follows Proposed New Products. figure U8-5
Grouping Documents into Sections

You can organize your computer notebook, as you would a paper notebook, by placing related pages together in sections and subsections.

Creating a Section

1. Turn to the Table of Contents
2. Draw a caret ▲
3. Choose Create Section from the Create menu
   PenPoint inserts the new section where you drew the caret

If you choose the Create Section command without first selecting a location in the Table of Contents, PenPoint makes the section the last section of the Notebook.

To rename a section, choose Rename from the File menu, or draw a circle ○ on the name to change it in an editing pad.

When you create a section, PenPoint automatically inserts a section divider which lists the documents contained in it and works exactly like the notebook Table of Contents.

To delete a section draw a cross out X on the section title. But if you intend to use the section again, back it up to a disk before deleting it from PenPoint.
Moving a Document into a Section

Once you set up a new section you can create documents there or move existing documents into it.

To create a new document in a section, doubletap the section title to expand it, tap to select a location (tap Empty if there are no documents), and then choose a piece of stationery from the Create menu.

To move a document into a section, drag the document to a location within the section.

To move a document out of a section, drag the document outside the section. (Lift the pen when it’s aligned with the left margin)

Creating a Subsection

Sections can contain subsections. To create a subsection, open a section, select a location in it, and choose Create Section from the Create menu.

Subsections work the same way sections do. Each subsection has its own table of contents which lists the documents contained it. This information is repeated in the section and notebook Table of Contents.

You can make a section a subsection by moving it into another section. For example, you might move a section you’d created for a prospective client into a section for new clients.

You can also promote a subsection to a section by selecting it and moving it outside the section to another location on the Table of Contents.
MOVING AROUND THE NOTEBOOK

Turning to a Page

The Table of Contents displays all the documents contained in the Notebook. From it you can use gestures or the View menu commands to turn to any page in the notebook or float one over the Table of Contents.

- Turn to a page by tapping the document’s page number, or
- Float a page by double-tapping the page number

Before floating a document, first select the option for floating documents on the Misc option sheet in Preferences. You only need to set this option once to be able to float documents any time you use the Notebook.
MOVING AROUND THE NOTEBOOK

TURNING TO A PAGE

Instead of using gestures to turn to or float a page, you can choose equivalent commands (Turn to and Bring to) from the View menu. Select the title in the Table of Contents and then choose the appropriate command.

If you’re not working on the Table of Contents you can thumb through the notebook by pressing the arrows near the page number or drawing flicks in the title line.

Tap the left arrow to go back to the previous page

Tap the right arrow to turn to the next page

Press the arrows to flip through the pages

You can also draw flicks in the title line to turn to the next page (flick left) — or go back to the previous page (flick right) —. Think of this as thumbing through a notebook; you turn a page to the left to see the next page, and to the right to go back to the beginning. A double flick right — turns to the Table of Contents.
Using Notebook Tabs to Mark Pages

Tabs offer a quick way to identify a page and turn to it or float it over any other page in the notebook. You can attach a tab to any document or section by drawing gestures or by displaying the column of tab boxes and tapping its tab box.

Attaching and Deleting Tabs

To attach a tab, draw a T on the document or section title. To remove it, draw the T again.

When you attach a tab, the Lombard automatically labels it with the document title.

Since a long document title won't be fully shown on the tab, you can rename the tab with a shorter or more useful title. To rename a tab, draw a circle O on the text to display the title in the editing pad and change it there.

Renaming a document changes its tab label. However, if you change the document title after editing the tab label, PenPoint doesn't automatically change the tab label.

For details on editing tab labels, see “Editing Labels, Document Titles, and Fields” in chapter 6 (Editing and Formatting Text).

If you're working on a page other than the Table of Contents, you can also attach a tab by drawing the T on the document title line.
Attaching Several Tabs

In managing the notebook, you may find it more convenient to attach and remove several tabs at once.

1. Turn to the Table of Contents
2. Tap the Tab Box command on the Show menu

A checkmark indicates the page has a tab

To attach a tab, tap inside the box
To remove it, tap again

(object screen) Tab command selected on Show menu; (screen) TOC with tab boxes; leader line to box with checkmark to show page has a tab; tap gesture on empty box figure 8-11
Displaying Tabs

When you have more tabs than can fit along the edge of the notebook, they appear overlapped.

To see the hidden labels, draw flicks on the tabs. To see all the tabs at once, flick left — on any tab. You’ll see the tabs in several rows.

Flick left — to see all the tabs at once. The row of tabs will collapse again as soon as you do anything else.

To move the overlapped tabs to the top, double flick up

To move the overlapped tabs to the bottom, double flick down

To see an overlapped tab:

Flick up on the tab above it

Or, flick down on the overlapped tab

Several diagrams of a row of tabs with each gesture made on same tab; show the different results figure 8-12
A GoTo button lets you hop from one document to a second document. It provides a quick way to move between two pages without using the Table of Contents.

1. Start from the document from which you want to jump

2. Float the Table of Contents by double tapping its tab

3. Tap to select the document you want to jump to
   - If you select the document title, the GoTo button takes you to the top of the document. To go to a specific place within the document, float it and tap to select a location.

4. Draw a go to button on the first document where you want the button
   PenPoint places a Goto button there and labels it with the title of the floating document

GoTo buttons work like page numbers in the Table of Contents:
- Tap the button to turn to the linked document, or
- Double-tap to float the linked document over the first.
MOVING AROUND THE NOTEBOOK
USING GOTO BUTTONS TO MOVE BETWEEN PAGES

To make a link to an embedded document, float the document that contains the embedded document, draw a plus + on the embedded document’s icon to select it, and then draw a go to button ⯊ on the first document.

You can insert several buttons in a document and have each one turn to a different page or to the same page. If you have a long document, however, you may be working on a page that doesn’t show the GoTo button. In this case, you might find it more useful to place the button in the cork margin where it’s always available. To find out how to use the cork margin, read “Customizing the Notebook” in this chapter.

To delete a GoTo button, draw a cross out × over it. To move it, draw a plus + on the button to select it, press then drag it to a new location.

You can rename the button label by drawing a circle ○ on it and editing the text. See “Editing Labels, Document Titles, and Fields” in chapter 5 (Editing and Formatting Text).

When you print the document, PenPoint prints the text on the button. Move the GoTo button to the cork margin to avoid this.
Customizing the Notebook

Setting Preferences

Your Notebook comes with certain options preset, such as the screen layout. You can change these options in the Preferences (notebook) on the bookshelf. Preferences includes options for:

- Writing in uppercase and adjusting the size and shape of the writing pads
- Aligning the pen
- Setting the time and date
- Choosing a left-handed or landscape layout
- Choosing a system font and a font for text in fields
- Enabling floating, zooming, and the warning beep
- Lengthening or shortening the time interval between doing something, drawing a gesture, pressing something, writing and PenPoint interpreting it

If more than one person uses the Notebook, you can have PenPoint remember these changes. To find out how to save your preferences read “Installing Programs and Devices” (chapter 3).

Choosing a writing style and aligning the pen are covered in “Writing in the Notebook” (chapter 5).
Setting the Time and Date

Programs and accessories that display the time and date refer to the settings on the Preferences option sheet.

To reset the time:

1. Tap the Preferences icon on the bookshelf.

2. Tap the arrow on the title line to see the other sheets and tap to choose the Time sheet if it's not displayed.

   Write in the new Hour, Minute, Second.

   Tap to choose a time period.

   Tap to choose a Time Zone.

   Tap to choose a Time Format to display the time in 12 or 24 hour intervals.

3. Tap the appropriate button.

If you change time zones, you don't need to reset the time. Choose a time zone and PenPoint automatically calculates the new time.
CUSTOMIZING THE NOTEBOOK
SETTING PREFERENCES

To change the date:

1. Tap the arrow on the title line to see the other Preferences sheets and tap to choose the Date sheet if it’s not displayed.

   Write in the new Month, Day, Year

   Tap to choose a Date Format

   (object) Preferences icon; Pref notebook showing Date sheet date format options displayed to show the different choices. figure U8-15

Turning On the Warning Beep

When PenPoint displays a confirmation or error message, you need to respond to the message on screen or PenPoint can’t carry out your command. As a further signal, you can have PenPoint sound a warning beep when it displays the message.

To turn on the warning beep, display the Misc sheet in Preferences and tap On.

Choosing System Fonts and User Fonts

PenPoint uses a system font to display information such as menu commands, titles on the Table of Contents and tabs, and a field font for the information you enter in writing pads and fields (on option sheets and forms).

You can change the style of each font. Whatever size you choose, however, applies to both fonts.

1. Tap the Preferences icon on the bookshelf

2. Tap the arrow on the title line to see the other sheets and tap to choose the Fonts sheet if it’s not displayed

   Tap to choose a font size

   Tap to choose a System and Field font

   (object) Preferences icon; Pref notebook showing Fonts sheet figure U8-16

Choose text fonts for documents from text option sheets.
Choosing a Screen Layout

PenPoint offers several screen layouts to accommodate different writing tasks and writing preferences.

1. Tap the Preferences icon on the bookshelf.

2. Tap the arrow on the title line to see the other sheets and tap to choose the Layout sheet if it’s not displayed.

3. Tap the appropriate option.

Choose Landscape when you’re working on a drawing or a task that requires more horizontal than vertical space on the page.

Choose the layout that corresponds to the hand you write with.
CUSTOMIZING THE NOTEBOOK

Moving Items on the Bookshelf

You'll probably find that you use some items on the bookshelf more frequently than others. You can move the ones you use less often to a second shelf and also rearrange their order in a way that's more convenient.

For example, once you've customized the notebook and the Create menu, you might move the Preferences icon and Stationery notebook to the second shelf and put in their place the In and Out boxes you use daily to send and receive faxes.

1. Drag the handle up

2. Press hold the icon until you see the animated line, and then drag it to the second shelf

To hide all the bookshelf items, drag the handle down until it covers both shelves.

To move an icon to another position on the shelf, press hold and then drag it to the new position.
When working with the Help notebook, you may find it useful to annotate it with tips and information you've discovered while working with your GO Computer.

To add a new document, draw a caret \( \wedge \) on the Table of Contents where you want the document to go and choose a piece of stationery from the Create menu.

If you no longer need to refer to a document, you can delete it by drawing a cross out \( \times \) on its entry in the Table of Contents.
The cork margin is an area at the bottom of the document where you can put GoTo buttons, new or embedded documents, and accessories. You have access to things you’ve placed there no matter where you are in the document.

PenPoint doesn’t print what’s on the cork margin, so you can move buttons and closed embedded documents there when you don’t want their icons or labels printed.

The cork margin is always part of a document, but it's usually hidden from view.

To display it, draw a C in the document title line.

Draw a C again to hide it and everything on it.

(screen) contract with C drawn in title line; each of these elements already in the cork margin: 1st item should be new doc labeled Notes; 2nd item should be an embedded doc (the package letter); 3rd item goto button labeled “technical” (goes to word technical in item #1 of contract); 4th item goto button to Send List; 5th item calculator

You can also show the cork margin by drawing a check ✓ on the document title line to display the document option sheets and selecting Cork Margin on the Access sheet.
CUSTOMIZING THE NOTEBOOK USING THE CORK MARGIN

Use the cork margin when you want to annotate a document. To insert notes and instructions in the cork margin, draw a caret \(^{\Lambda}\) to display the Create menu, and then tap to select a new piece of stationery.

You might also move an existing document, such as a To Do list, to the cork margin so you can update it while working on the current document. To put it in the cork margin, copy or move it from the Table of Contents.

Place GoTo buttons in the cork margin to turn quickly to parts of the document you want to see without having to scroll through the document to find them. To insert a GoTo button in the same document, select a word and draw the gesture for a GoTo button \(^{\bigcirc}\) in the cork margin. To insert a GoTo button to turn to a different document, select the document in the Table of Contents, and draw the gesture for a GoTo button \(^{\bigcirc}\) in the cork margin.

To have easy access to an accessory, such as the calculator, copy the icon for it to the cork margin.

---

To change the location of a GoTo button in the same document, select a new word and triple tap the button. PenPoint changes the label to reflect the new location.
CHAPTER 9

Printing, Sending, and Receiving Documents
Once you create a document you can print it, fax it, or send it as electronic mail. You can also receive incoming documents and faxes. If you’re connected to a printer or a fax/data modem, you can print or send documents as soon as you’ve finished them. If you’re not connected, PenPoint stores the document in the Outbox with your printing or mailing instructions.

The equipment you normally use when you print or mail a document comes with a device driver (the program that tells the GO Computer how to use it). You install the device driver with the Installer the same way you install other programs in your Notebook.

After installing the driver in your Notebook, you set options for it in the Device notebook so that PenPoint knows, for example, which port you’ll connect it to. You only set these options once for each piece of equipment you plan to use. Thereafter, you choose the send and print commands to prepare the document.

To find out how to install the equipment, read “Setup and Care”. To learn how to copy the device driver to your Notebook and set options for the equipment, read “Installing Programs and Devices” in chapter 3. If you plan to use a printer on a network, refer to Connecting to a Personal Computer.
Printing a Document

Once you finish working on a document, you may want to produce a printed copy for your files or to send to someone else. Before printing the document you can format it by setting margins and adding headers and footers with the Print Setup command from the Edit menu. Then, when you're ready to print, choose the Print command.

Choosing a Page Layout

1. Choose Print Setup from the Edit menu.

2. Tap the arrow on the title line to see the list of sheets and tap to choose the Layout sheet if it's not already displayed.

3. Set the appropriate options:
   - choose a page layout
   - choose a paper size
   - write in the number of inches for each margin

3. Tap the appropriate button.

You can print the document without changing the Print Setup options (PenPoint uses the default settings). When you change the options, PenPoint applies them each subsequent printing of that document.
PRINTING A DOCUMENT

Adding Headers and Footers

1. Choose Print Setup from the Edit menu.

2. Tap the arrow on the title line to see the list of sheets and tap to choose the Headers sheet if it’s not already displayed.

3. Set the appropriate options:
   - choose the Font and Size
   - write in the number of inches from the top of the page to header, and the bottom of the page to the footer
   - choose Yes to print a header or footer on the First Page
   - write in the text
   - write pg. to print the current page number
   - write dt. to print the current date
   - write nm. to print the document name

3. Tap the appropriate button

(object) print headers setup sheet; .5 for header and footer margins; left header FastPak Design; right header dt.; center footer pg.

figure U9-2

Print the document to see the headers and footers.
1. From the document, choose Print from the Edit menu.

2. Tap the following options to:
   - select a Printer
   - choose a Paper Size
   - print the entire document
   - write in the range of pages
   - write in the number of Copies you want printed
   - choose Collation Off to print multiple copies of each page; Collation On to print multiple sets of each document.
   - write in the page number that should appear on the First Page you print (do this when you want to have continuous pagination for separate documents)
   - To change a number, write the new number on top of the old one.

   Or, draw a vertical pigtail ~ on the number to delete it (to delete several, draw a scratch out ≡ over them)

3. Tap the appropriate button.
PRINTING A DOCUMENT

To print a document from the table of contents, select the document title, choose Print from the Edit menu, and then follow the steps for printing a document.

If you're connected to a printer, PenPoint prints the document; otherwise it stores the document in the Outbox with your print instructions.

If you're using letterhead, check to see how much space you need to leave for the imprint and adjust the document, header, and footer margins accordingly. If you routinely print your documents on letterhead, you might create stationery for it with the margins preset. To find out how to do this, read “Creating Customized Stationery” in chapter 4.
Printing Embedded Documents

When you print a document, you also print all its embedded documents.
To avoid printing an embedded document, move the document to the cork margin. You can find out how to use the cork margin in “Managing the Notebook” (chapter 8.)

If an embedded document is near the end of a page, select Keep on Page to prevent the contents from being split between two pages.

To make sure that an embedded document always begins on a new page, select Begin on Page.

If you have resized the embedded document, PenPoint prints whatever shows on the screen. To print the entire document without resizing it, choose Print All Contents. If the embedded document is closed, only its icon is printed. To avoid printing the icon, move it to the cork margin.

To print the embedded document without printing the larger document, choose Print from the embedded document’s Document menu.

The larger document’s Print Setup option sheets override the Print Setup options for the embedded document. If you want to format the embedded document with its own margins and header and footer information, set the appropriate Print Setup options for the embedded document and then select Print All Contents. PenPoint prints the embedded document starting on a new page using the settings you’ve selected and then returns to the options for the document that contains it.
Reordering the Print Queue

When you’re not connected to a printer and you choose Print, PenPoint places the document in the Outbox. Later when you’re connected to the printer, PenPoint prints the documents in the order that they’re listed in the Outbox. If you need to print one of the documents that appears later in the queue, you can change the printing order by moving the document you want to print to the top of the list.
Filing Documents
Managing the contents of the GO Computer is similar to managing the contents of a looseleaf binder. Periodically, you remove pages you've finished working with or won’t need until a later date. Some documents get discarded, others copied for your files or for a colleague. You perform these filing tasks by copying and moving documents to and from disks.

You’ll most often transfer documents from the GO Computer to a disk:

✓ to keep backup copies on disk
✓ to use the space in the notebook most efficiently
✓ to work with them on a PC.

You’ll most often transfer documents to the GO Computer from disk:

✓ to move documents stored on disk back to the GO Computer so you can work on them again
✓ to work on a document created by someone else
✓ to restore an earlier version of a document
✓ to work on documents created on a PC.

You can transfer documents between the GO Computer and any connected disk, such as the GO floppy disk. If you’re using a new floppy disk, PenPoint will prompt you to format it when you insert the disk in the disk drive. If you have GO TOPS, you can transfer documents to and from a PC disk or network disk. (The “Setup and Care” chapter explains how to connect the GO Computer to a GO floppy disk or to a PC; Connecting to a Personal Computer explains how to use TOPS.)

You transfer documents by copying or moving them from the Notebook Table of Contents to the diskviewer, a table of contents that lists the documents on disk.

PenPoint stores documents in its own format, but you can continue working on them on a PC by changing the file format on the export sheet when you copy it to disk. Conversely, you can work on documents created on a PC by assigning a document PenPoint program on the import sheet when you copy it to the Notebook.
To copy a document to a disk:

1. Connect the GO Computer to a disk drive.

2. Tap the Disks icon on the bookshelf. The diskviewer floats on the page.

3. Tap the icon for the connected disk.

4. From the Notebook Table of Contents, tap hold the document or section you want to copy, and then drag it where you want it to go on the diskviewer table of contents.

5. Tap the close corner when you're done.

(screen) TOC with diskviewer floating on TOC; hold-drag capers to new location on diskviewer figure U10-1
Finding Out What’s on a Disk

Displaying the Diskviewer

Whenever the GO Computer is connected to a disk, you can display a diskviewer to find out what’s on that disk.

You’ll usually open the diskviewer from the bookshelf by tapping the diskviewer icon. (The diskviewer is also in Accessories.)

You’ll see an icon for each disk drive you connect to at the top of the diskviewer. For example, with TOPS running on the PC connected to your GO Computer, you’ll see the names of the volumes that you’ve published.

For information about getting files to or from a PC drive on a network, see Connecting to a Personal Computer.
FINDING OUT WHAT'S ON A DISK

1. Connect the GO Computer to a disk drive (to see the contents of a floppy disk, insert it in the drive).

2. Tap the Disks icon on the bookshelf to float the diskviewer.

3. Tap the disk icon to see the contents of a disk:
   - tap the disk name to hide them
   - flick on the page to scroll the diskviewer

Directories organize information on disk. They may contain PenPoint documents and sections as well as PC files and subdirectories:
   - Double tap a section or a directory title to see a list of its contents
   - document created on a GO Computer
   - document created on a PC
   - document created on a GO Computer but exported in a PC file format

4. Tap the disk name to close the icon.

5. To see the contents of another floppy disk, draw a cross out X over the disk icon to eject the disk and insert another floppy disk.

6. Tap the close corner when you're done.

(object) Disks icon; (screen) TOC with diskviewer floating on TOC and leader lines:
for disk name (not name under icon but name on diskviewer menu line): "Sales & Products"
for section: "Sales Reports"
for GO doc: "Sales by Region"
for exported doc use "Weekly Report"
for PC doc: "DISTSALE.TXT" figure U10-2

If you connect to another disk while working with the diskviewer or reconnect to a volume on a network and you don't see the volume's icon, choose Refresh from the View menu to display it.
FINDING OUT WHAT'S ON A DISK

You can also eject a disk by choosing Eject & Forget or Eject & Remember. Eject & Forget closes the icon and ejects the disk. Eject & Remember ejects the disk but continues to display the icon. Since the disk is no longer connected, the icon is dimmed. However, PenPoint remembers what's on the disk. Use this command when you want to copy documents from one floppy disk to another. If you choose Eject & Remember and then decide you don't need to work with the disk, you can close and dismiss the dimmed icon by tapping the disk name.

As a shortcut you can draw a cross out X on the disk icon for Eject & Forget and the letter E on the icon for Eject & Remember.
FINDING OUT WHAT'S ON A DISK

Creating Diskviewer Stationery

If you often connect the GO Computer to several disks, for example to a PC on a network, you may find it more convenient to create diskviewer stationery that's preset for the disk you use most often.

You create diskviewer stationery by copying the diskviewer into the stationery notebook. If you want, you can add it to the Create menu by tapping its Menu box in the stationery notebook. You can then create a new document in the usual way by drawing a caret in the table of contents where you want the stationery to go, and selecting a piece of diskviewer stationery from the Create menu.

You work with the diskviewer document as you would any document. That is, you can float it, move it to a different location in the notebook, and attach a tab to it.

Finding Out More About What's on Disk

The diskviewer menus are similar to the Table of Contents menus. Commands on the View, Sort, and Show menus give you more information about the documents, such as its size, the type of program used to create it, and the date on which you last changed it. You can use these commands, for example, to see which is the most recent version of a document you've stored on disk.

To find out more about the disk:

1. Choose the About command on the Volume menu

   The total space on disk and the amount of space remaining

   Read Only tells you whether you can copy or move information onto the disk (if you can Read Only will be No)

(object screen) About dialog

To change a disk so you can copy or move information on it, eject the disk, and then push up the tab covering the hole on the upper right side of the disk so that it no longer blocks it.

As a shortcut you can draw a check on the disk icon to see the About option sheet
Creating New Directories

You can organize the contents of a disk by creating a directory and then moving PenPoint sections, documents, as well as PC files in them.

1. Tap a title to select a location for the directory (selecting a location within a directory creates a subdirectory).
2. Choose Make Directory from the Edit menu.
3. Double tap to open the directory.
4. Move the documents into the directory by pressing and holding on the document title and then dragging it so that the pen point is aligned with the “Empty” placeholder document.

(object) diskviewer; Edit menu with Make Directory selected;
(object) Sales & Products disk: in Sales Region Dir. make new Dir and move section Sales Visits into it

figure U10-4

The diskviewer is preset to list titles alphabetically, so the new directory is placed under the d's. You can rename it in the usual way.
Renaming a Disk and its Documents

You can rename the title of any connected disk by drawing a circle \( \bigcirc \) on the icon and changing it in the editing pad or by choosing About from the Volume menu and writing in a new name. To rename a document or directory, draw a \( \bigcirc \) on the title and change it in the editing pad or choose the Rename command in the Edit menu.

To review the procedures for renaming a document see “Creating and Using Documents” (chapter 3) and “Editing Labels, Document Titles, and Fields” in chapter 6.

Deleting Documents from the Diskviewer

To delete a document from disk, draw a cross out \( \times \) through the title, or select the title and choose Delete from the Edit menu. You’ll see a confirmation message.
Transferring Documents

Transferring Documents and Sections to and from the Notebook

You transfer documents from the GO Computer to a GO or PC disk by copying or moving them from the Notebook to the disk shown on the diskviewer.

Transfer documents to disk to make backup copies, free up more room on the GO Computer, and keep the notebook up-to-date. To continue working on it on another computer, export it. See “Converting a PenPoint Document to a PC Format” in this chapter.

1. Connect the GO Computer to a disk drive
2. Tap the Disks icon on the bookshelf to float the diskviewer
3. Tap the icon for the connected disk
4. From the Notebook Table of Contents, tap and hold the document or section you want to copy, and then drag it where you want it to go on the diskviewer table of contents
5. Tap the close corner when you’re done

Most of the time you’ll want to open a disk before copying or moving a document to it to see where to put the document. However, you can transfer a document to a disk icon when it’s closed. When you open the icon later, you’ll see the document listed alphabetically with the other contents on disk.

To transfer a document or section to the Notebook, simply reverse the procedure above. If you’re copying a file from another computer, PenPoint displays the Import sheet and asks you what program to use with it.
Transferring Documents Between Disks

You can use the diskviewer to transfer documents between disks. You might do this to consolidate all the client documents stored on various floppy disks to one disk, or to make a copy of a document you keep on your hard disk.

1. Connect the GO Computer to a disk drive
2. Tap the Disks icon on the bookshelf to float the diskviewer
3. Tap the icon for each connected disk
4. Press hold then drag the document to its destination

show diskviewer with hard disk and floppy disk TOCs displayed and "Quarterly sales rept" being dragged from hard disk TOC into "New Sales Rep" floppy disk TOC
figure U10-7
TRANSFERRING DOCUMENTS

Sometimes the document you want to transfer to a floppy disk is stored on another floppy disk. Since you’re using a single disk drive, you’ll need to eject the first disk and insert the second to transfer the information.

1. Connect the GO Computer to a disk drive and tap the Disks icon to float the diskviewer.

2. Tap the floppy disk icon to see its contents.

3. Draw the letter E on the icon to eject the disk (or choose Eject & Remember from the Volume menu).

4. Insert a second floppy disk.

5. Tap the icon to see its contents.

6. Copy or move the document from one disk to the other in the usual way. (PenPoint prompts you to reinsert the disk. Continue swapping disks until PenPoint completes copying the data.)

(screenshot) diskviewer with "Sales & Products" floppy disk open and Eject & Remember selected from Volume menu

(screenshot) diskviewer with "Sales & Products" TOC dimmed, and TOC for second floppy (labeled "New Sales Rep") open (no docs in it);

show "New Product Ideas" section from the "Sales & Products" being copied to "New Sales Rep" disk

figure U10-8

To close and dismiss a dimmed icon, tap its disk label.
Copying and Duplicating Disks

The Volume menu has two commands that let you copy the contents of a disk to another disk.

Choose the Duplicate command to make an exact copy of a floppy disk onto another floppy.

Choose the Copy Contents command to copy the entire contents of a directory on another disk. For example, you might copy all the new hire contracts you've stored on a floppy disk to the personnel directory on your hard disk.

To duplicate a disk:

1. Connect the GO Computer to a disk drive.
2. Tap the Disks icon to float the diskviewer.
3. Tap the floppy disk icon to see its contents.
4. Draw the letter D on the icon (or choose Duplicate from the Volume menu).
   PenPoint begins to duplicate the disk and shows you the amount it's copied.
   Insert a second floppy disk when PenPoint prompts you for the destination disk (if the disk is unformatted PenPoint formats it).
   Insert the first floppy disk when PenPoint prompts you for the source disk.
5. Continue swapping disks until the percent completed is 100% and the message is no longer on the screen.

If you duplicate a disk onto an unformatted disk, PenPoint automatically formats the disk before copying the contents onto it.
COPYING AND DUPLICATING DISKS

To copy the contents of a disk to a directory on another disk:

1. Connect the GO Computer to a disk drive
2. Tap the Disks icon to float the diskviewer
3. Tap hold the floppy disk icon until you see the moving double-dashed lines
4. Drag the disk icon to its destination

(If you're dragging it to a directory, lift the pen when the disk icon is aligned with other documents within the directory)

You can also copy the contents by choosing Copy Contents from the Volume menu, and then dragging the disk icon to another volume or directory on the diskviewer.

Copy Contents will be implemented in the Beta release. jm September 25, 1990
PenPoint stores your documents in the PenPoint format. To work with a PenPoint document on a different computer, you need to convert the document from a PenPoint file format to one that is compatible with the program that you'll be using. Consult your PC manual if you're not sure what file formats the PC program accepts.

You assign a document a PC file format by exporting it.
CONVERTING A PENPOINT DOCUMENT TO A PC FORMAT

1. Connect the GO Computer to a disk drive

2. Select a document to export from the Table of Contents

3. From the Table of Contents, choose Export from the Document menu
   You'll see the Export sheet with the title of the document you've selected

4. To assign the document a different name on disk:
   - draw a X through the title and write in a new name
   - Or, tap the title to change it in the editing pad

5. Tap to select a file format if necessary

6. In the Destination section, tell the GO Computer where to put the document. Tap to open the disk icon and then select a location

7. Tap Export to export the document
   The GO Computer transfers the document to disk, lists it alphabetically, and closes the Export sheet
   Tap Cancel to close the Export sheet without exporting the document

(screenshot) TOC with New Package Design Letter selected and Export selected on Document menu (this part is so straightforward we could drop this part of the figure to shorten it)

(screenshot) TOC with Export sheet, name rewritten in editing pad to “PkgLtr.RTF” (we’ll skip the step of how to clear the pad and just write in the new text); tap gesture on file format; tap on New Products section of Sales and Products floppy disk (this is where the New Pkg letter will be exported to)
figure U10-11

Refer to “Editing Labels, Document Titles, and Fields” (chapter 6) to learn more about editing document names.
CONVERTING A PENPOINT DOCUMENT TO A PC FORMAT

In your Notebook you can have a document title that includes several words with spaces between them. On many PCs, however, the convention for naming documents requires titles of 8 characters followed by a period and 3-letter extension to identify the file format, for example NewProd.RTF.

If you don't rename something with a long title, the PC may truncate it when you export it. For example, if you export a document called “New Bottle Design” in ASCII format, when you look at the document on your PC directory, you'll see a document entitled “New_Bott.txt” (the PC inserts an underline instead of a space).
Converting a PC Document to a PenPoint Document

Sometimes you'll want to work on documents created originally on the PC. For example, you might wish to add details to a sales plan prepared by a colleague. Or, you might decide to work further on a document you'd already exported to the PC.

You transfer documents back to your Notebook copying or moving them from disk to the Notebook. If you're copying a PC file or a document you previously exported, PenPoint automatically displays the Import sheet and asks you what program you want to use with it.

To import a non-PenPoint document without choosing a program select None from the Import to options. When you turn to the document later, PenPoint asks you which program to use with it.
CONVERTING A PC DOCUMENT TO A PENPOINT DOCUMENT

1. Connect the GO Computer to a disk drive
2. Tap the Disks icon to display the diskviewer
3. Tap the Disks icon to see its contents
4. Tap then press and drag the document you wish to import to its destination on the Table of Contents
   PenPoint displays the Import sheet
5. To change the document name:
   ▲ draw a X through the title and write in a new name
   ▲ Or, tap the title to change it in the editing pad
6. Tap to select a program
7. Tap Import to import the document
   PenPoint copies the document to the Notebook and closes the Import sheet
   Tap Cancel to close the Import sheet without importing the document

(screen) TOC diskviewer displayed for Sales and Products floppy disk and "DistSale.txt" doc being dragged to TOC:

(screen) same as above except with Import dialog sheet displayed and Import to options showing with TextEditor selected

figure U10-12

Refer to "Editing Labels, Document Titles, and Fields" (chapter 6) to learn more about document names.
Formatting a Floppy Disk

Before you can use a disk in the GO Floppy disk drive, you need to format it. The first time you put an unformatted disk into the GO floppy drive you’ll see a message asking you to choose a memory size for formatting.

1. Insert the unformatted disk into the drive
   You’ll see a message informing you that the disk needs to be formatted

2. Choose a memory size
   (If you don’t know what the size is, eject the disk and check the size that’s written on the metal shutter)
   If you’ve mistakenly inserted a disk with information on it you want to keep, tap Cancel to eject the disk

3. Write in a name for the disk

4. Tap Continue
   You’ll see a message that shows you that the format is in progress
   When PenPoint finishes formatting the disk, the message disappears and if you have the diskviewer open, the disk icon appears there

(2 object screens showing primary messages): 1st asking whether to format disk, 2nd asking for the disk size and name
figure 10-13

You can also format a disk from the diskviewer by choosing Format from the Volume menu. You might do this to format a disk to a lower density or to quickly erase its contents.

If you get a message telling you that the disk is a write protected volume, make sure you don’t need the information on it. Then push up the tab covering the hole on the upper right side of the disk.
Back Up Your Notebook

It's advisable to back up your Notebook periodically by copying it to a disk. Then if you have an error that causes you to lose data, you can restore your Notebook to its original configuration.

To back up the Notebook:

1 Tap the Disks icon to open the diskviewer

2 Tap to open the disks icon into which you want to copy the Notebook

3 Tap then press the Notebook icon until you see the moving double-dashed line that tells you it's ready to be copied

4 Drag the Notebook icon to the disk

To find out how much space the Notebook will occupy on the disk, choose About from the Table of Contents' Document menu and check the Filed Size. Then compare this amount with the amount of space on the disk. (Choose About from the disk's table of contents' Document menu to see how much free space remains on the disk.)
The GO Computer

Top edge view

Expansion card slot
Universal Connector
Screen contrast slider
Pen storage slot (sliding cover shown in closed position)

Front view

On/Off button
Pen-sensitive screen

Face-down view (battery pack removed)

Battery power contacts
Battery retaining lip

Battery pack (cover down)
The GO Floppy Disk Drive

The GO floppy disk drive is used to transfer documents and programs between the GO computer and floppy disks. The GO floppy disk drive snaps together with the Quick Charger or directly to the GO computer with the base station cable.
The GO Quick Charger

Front/right-side view

AT Keyboard plug
Serial port (to printer)
Base station cable connector

---inch base station cable with Universal Connectors (to GO computer, PC, or Macintosh)

Rear/left-side view

Coupling latch for GO Floppy Disk Drive
RS422 AppleTalk connector serial/network port to PC or Mac
Connector slot (to GO Floppy Disk Drive)
AC power connector

---inch AC power cord (to wall socket)

The GO Quick Charger connects to the GO computer to quickly recharge its battery and to provide AC power for computer operation. The Quick Charger snaps together with the GO Floppy Disk Drive to provide power for simultaneous computer and disk drive operation. The Quick Charger also provides ports that can connect the GO computer with serial printers and RS232 devices, AppleTalk and TOPS networks, PC or Macintosh computers, and an AT computer keyboard.
The GO Travel Charger

The GO Travel Charger connects the GO computer to an AC power outlet for recharging the computer's battery, and to provide power for computer operation. The Travel Charger includes an AC power cord with standard wall outlet plug.
When the special tip of the GO Pen wears down too much, continuing to use it can cause damage to the GO Computer's screen. Four replacement pen tips and the GO Pen Tip Remover tool are supplied with the GO Computer so that you can easily make this replacement.

The GO Pen Tip Remover

1. Squeeze the GO Pen Tip Remover together so that it grasps the worn down white pen tip.

2. Gently pull until the worn tip is released and slips out of the pen.

3. Insert one of the extra pen tips into the pen and press it in with your thumb until it clicks into position.
Connecting to a Personal Computer
Connecting to a Personal Computer
Trademarks

Apple
AppleTalk
IBM
LocalTalk
Macintosh ...
MSDOS ...
Novell...
OS/2 ...

PostScript is a registered trademark of Adobe Systems Inc.
The spelling portion of this product is based on Spelling and Thesaurus Technology from Franklin Electronic Publishers.

The PROXIMITY/Merriam-Webster LINGUIBASE
Copyright © 1983
Merriam-Webster, Inc.
Copyright © 1983. All Rights Reserved
Proximity Technology, Inc.

Words are checked against the 83,000 word Proximity/Merriam-Webster Linguibase.

SoftTalk
TOPS
UNIX is a registered trademark of AT&T.

All other products or services mentioned in this document are identified by the trademarks or service marks of their respective companies or organizations.
How to Use this Manual (To Come)
  If You are Connecting to One Personal Computer (PC)
  If You are Connecting to a PC on a Network
  If You Want to Learn about TOPS
  If You Want to Copy, Move, or Print a Document
  If You Have a Problem
  If You Want to Know What a Term Means

Chapter 1: What Connecting Does for You (To Come)
  What PenPoint Provides
  The Way Information Flows
  How Your GO Computer Connects to a PC
  How TOPS Lets Your GO Computer and PC Communicate
  When Your PC is Part of a Network

Chapter 2: QuickStart
  What You Need
  A Bird's Eye View of the Installation Process
    Installing the TOPS FlashCard
    Connecting the Cables
    Installing TOPS
    Customizing TOPS
    Specifying the Directories to Make Available to the GO Computer
    Loading TOPS on the GO Computer (Alpha Only)
    Verifying the Connection
  And Now...

Chapter 3: Working with Files on the PC
  Starting to Use TOPS on the PC
  Publishing a PC Volume
  Displaying the Contents of a PC Volume
  Listing What's Been Published
  Changing the Name or Access of a Published Volume
  Removing Access to a Volume (Unpublishing)
  Storing PenPoint Software on Your PC (To Come)
  If the GO Computer Crashes While Using a PC Volume

Chapter 4: Exchanging Files
  Overview: Different Ways to Transfer a File
  Finding Out What's in a Published Volume
  Transferring Documents from the GO Computer
  Transferring Documents to the GO Computer
  Converting an MS-DOS File for Use on the GO Computer
  Converting a GO Document to MS-DOS Format
  Installing Software from the PC
  Installing Fonts from the PC
  Loading PenPoint from the PC
Chapter 5: Printing (To Come)
Troubleshooting (To Come)
Glossary (To Come)
Index (To Come)
Chapter 2
Quick Start

The PenPoint operating system in your GO Computer lets you exchange documents, programs, and fonts with an MS-DOS personal computer (PC). The PC must be prepared for file access, though. You get the PC ready by installing a program called TOPS.

In general, to install TOPS on your PC, you should follow the detailed instructions in the manuals that accompany the TOPS products. This chapter adds some specific recommendations to make TOPS work smoothly with your GO Computer.

This chapter also provides you with an overview of the process of connecting the computers via a TOPS FlashCard, TOPS TeleConnector, GO cables, and the TOPS software.

Alpha Note: When you receive the beta version of the PenPoint 286 operating system, you will be able to use a GO-supplied asynchronous cable to connect your GO Computer to a serial port on your PC. Using this cable, you will be able to exchange files without a TOPS FlashCard and TOPS TeleConnector. In addition, you will be able to connect to an Apple Macintosh computer using another GO-supplied cable. (Stay tuned!)

What You Need

To prepare an MS-DOS personal computer to exchange files with your GO Computer, you need the following:

✓ A TOPS FlashCard, a TOPS TeleConnector, and the TOPS program Version 3.0 or later (available from your computer dealer)

✓ A PC with a hard disk

✓ A cable to connect the PC with your Quick Recharger or GO Computer (available from GO).
A Bird's Eye View of the Installation Process

To prepare the PC to exchange files with your GO Computer, you need to:

1. install a TOPS FlashCard in your PC

2. connect a TOPS TeleConnector cable to the TOPS FlashCard, and from the end of the TeleConnector, string a GO cable to your Quick Recharger or GO Computer

3. install a program called TOPS on your PC hard disk

4. customize the TOPS program for your particular situation

5. specify the PC directories you want to make available to the GO Computer

6. load TOPS onto the GO Computer (only necessary in this alpha release)

7. verify that you have succeeded in establishing the connection between the two computers

You'll find the instructions for all these steps — except plugging in the GO cable — in the manuals that come with the TOPS FlashCard, TOPS TeleConnector, and TOPS program. In this chapter, we provide a few extra recommendations that will help make your TOPS program work at its best with the GO Computer.
Installing the TOPS FlashCard

The TOPS FlashCard sits in a slot inside your PC and carries information from the PC to an external cable known as the TOPS TeleConnector. The TeleConnector ends in a box which accepts the GO cable leading to your Recharger or GO Computer. When you install the TOPS program, it uses the FlashCard and the linking cables to transfer files back and forth between the MS-DOS computer and the GO Computer.

TOPS and the TOPS FlashCard can use several different ways to send messages known as interrupts to the PC operating system, MS-DOS, and several different paths to exchange information with a high-speed area in the computer's memory known as Direct Memory. Unfortunately, MS-DOS does not offer many different methods or paths, so you may encounter a conflict between TOPS and the software that allows you to communicate with another network or some piece of hardware. If you have connected your PC to a network other than TOPS, 16-bit cards, or a second serial device, you should get out their manual to see what options you chose for interrupts and Direct Memory Access.

If you are installing a FlashCard for the first time, follow the FlashCard manual to make these changes:

- If you anticipate no conflict, or if you have to use two serial ports, leave the Interrupt Jumper (Jint) set to Interrupt Request #2 (IRQ2).
- If you anticipate a conflict with some other device such as a 16-bit card (which uses IRQ2), and do not need to use a second serial port, set the Interrupt Jumper (Jint) to Interrupt Request #3 (IRQ3).
- If you already have another network's card installed in your PC, and if you are going to be using extended memory for TOPS (a good idea), TOPS will be using IRQ5, so you need to set the other network's Interrupt Request to IRQ7.
- Use the Direct Memory Access Jumpers (Jd1 and Jd2) to set the Direct Memory Access Acknowledge line and Direct Memory Access Request line to 3 (DACK3 and DRQ3), but recognize that there may be a conflict with any other device or card that has been set up to use Direct Memory Access, so you may have to assign the other device DACK1 and DRQ1.
- If another device uses the same address for input and output as TOPS (TOPS uses 398), you may need to change the jumpers on the FlashCard to another address, or change the address for the other device, to avoid a conflict.

Leave the other options with their default values.
If you have already installed a TOPS FlashCard and TOPS TeleConnector, you
do not need to re-install them, or to change any of the jumpers. Attach the GO
cable to the box at the end of the TOPS TeleConnector, customize the TOPS
program as outlined in this chapter, then load the software, and start to transfer
files. If you encounter any difficulties, change the jumpers as recommended
here; if you still have difficulties, please call the GO Hotline to discuss your
situation and find out how to adjust your jumpers.
Connecting the Cables

The TOPS TeleConnector is a cable that attaches to the FlashCard. It ends in a box that accepts one or two phone jacks. Follow the directions that come in the TOPS TeleConnector box.

One end of the cable supplied by GO connects to the TeleConnector box. The other end plugs into your Recharger or the GO Computer.

If your PC is already part of a TOPS network, another cable should lead from your PC's TOPS TeleConnector box to a similar box attached to the next PC in the network. If your PC is not part of a TOPS network, be sure to insert the terminal resistor in the second slot, to prevent static on the line.

If you wish, you may use another GO cable to connect a second GO Computer to the same PC. Just remove the terminal resistor from the box at the end of the TOPS TeleConnector, and plug in the second GO cable.

Cabling diagram, showing which end of the TOPS TeleConnector to plug into the FlashCard, and how; how to plug one end of the GO Cable into the TeleConnector box, and the other end into Recharger or GO Computer; also show a terminal resistor in the second slot of the TeleConnector box.
TOPS is the software that makes some or all of the files on your PC hard disk or floppy disk available to you when you are using the GO Computer. You need to install TOPS on your hard disk; the program and its related files will take up about 2.5 megabytes of space.

To install TOPS, use the TSETUP program, and follow the instructions in the manual titled *TOPS User's Guide to File Sharing and Printing for DOS*. We recommend that you allow the TSETUP program to modify the PATH statement in your AUTOEXEC.BAT file so that you can run TOPS from any directory on your PC.
To customize TOPS for your own situation, you should continue using the TSETUP program, choosing C on the Main Menu to configure the software. You need to carry out three tasks:

✓ Configuring the Driver interface card (your FlashCard)
✓ Configuring your system (describing your system to TOPS)
✓ Configuring Client/Server networking options (defining what you want TOPS to do to make your PC act as a file server, providing file storage for the GO Computer).

In configuring the Driver interface card, you should work only on the FlashCard options. If you changed jumpers on the FlashCard, you should say so now. (We recommended that you change the Board IRQ Line to 3 and the DMA Channel to 3).

In configuring the system, that is, describing it to TOPS, we recommend that you:

✓ Use extended memory so that you can run other programs at the same time as TOPS.
✓ Assign your PC a meaningful station name (up to 16 characters).
✓ Fill in the Disk Drive Map carefully and completely, typing an F for the floppy drive A, F for Drive B even if your PC does not have a drive installed there, an F for each floppy or removable-disk drive attached to your PC, an H for each hard disk or RAM including any available on a network, and U for any unused drive. There are positions for 26 drives, one for each letter of the alphabet. If your PC is connected to a network that provides file servers named N, O, and P, you would space over to the slots reserved for N, O, and P, and type an H in each position. The drive map tells TOPS where to look for available files.
✓ Accept the default print file directory unless you have already set up another one.
✓ Create meaningful names for any printers directly connected to your PC.
✓ If your PC is part of a TOPS network that contains more than one Apple LaserWriter, Apple ImageWriter, or Apple LQ printer, and you want to specify a particular printer as the standard one, specify its name, type, and zone. (A zone is usually one work group’s part of a larger TOPS network.) If you don’t have a preference, leave the equal sign, meaning that TOPS can use any available printer. If you have no zones in your TOPS network,
leave the asterisk, indicating that TOPS should not bother looking for other zones.

In configuring Client/Server Networking options remember that for the GO Computer, the PC is only a server. The PC exists to provide file storage for the GO Computer, but the PC itself cannot act as a client, copying files from the GO Computer. You cannot sit at the PC keyboard and send files to the GO Computer or bring files from the GO Computer to the PC. You use the GO Computer to copy and move the files in both directions. If you have been using a TOPS network, you can continue to use your PC as a client to copy files to and from other PC's volumes. In the Client/Server Networking options, we recommend:

- If your PC is part of a TOPS network, choose to be a File Client, Network Printer Client, Remote Printer Client, Local Printer Client, and File Server. If your PC is not part of a TOPS network, choose to be a File Server.

- If your PC is part of a TOPS network that consists only of MS-DOS PC's, select PC-only Server.

- Choose to make your PC a Print Server, so that the GO Computer can use the printer attached to your PC.

When you have completed the configuration process and left the TSETUP program, you should add the line call loadtops to your AUTOEXEC.BAT file as recommended in the TOPS user's guide. That way, TOPS will be loaded whenever you turn on your PC.

To run TOPS from the MS-DOS prompt, type topsmenu. That brings up a series of menus offering you the commands needed to publish a volume, making its directory available to the GO Computer.
Specifying the Directories to Make Available to the GO Computer

With TOPS you need to publish the disk drive or directory containing the files you expect to exchange with the GO Computer. The disk drive or directory is known as a volume. Publishing makes the files in the volume available to the GO Computer, and lets the GO Computer store files in the volume.

You will find instructions in the TOPS User's Guide, and in this book, for publishing. If you are on a TOPS network, make sure that you only publish volumes that you want made public, because any other PC on the network can look through the files in a published volume. You cannot protect a volume with passwords if you want to use the volume with your GO Computer.

Beta Note: In the beta version of PenPoint you will be able to load the PenPoint operating system, software, or fonts from a published PC volume. If you want to store the PenPoint operating system, software, or fonts on your PC hard disk, you will need to go the root directory of any published volume, create a directory called PenPoint, and subdirectories with exactly the same names as those on the floppy disks that come from GO. For instance, the PenPoint operating system appears in a subdirectory called BOOT under the directory PENPOINT; some applications appear in a subdirectory called APPS within the PENPOINT directory; and fonts appear in a subdirectory called FONT within the PENPOINT directory. Once you have stored the PenPoint materials in the proper subdirectories, you will be able to use the PenPoint installer to load them into the GO Computer, as described in chapter 4, "Exchanging Files."
Loading TOPS on the GO Computer

Normally, you will not need to load TOPS on the GO Computer. TOPS will come built into the PenPoint operating system. But in the alpha release of PenPoint, you need to install TOPS yourself.

1. Put the Services Disk into the Recharger.

   A Quick Installer appears.

2. Select TOPS

3. Tap the Install button.

To confirm that TOPS has been installed, open the Installer, and turn to the Services page. You should see TOPS listed.

To have TOPS loaded any time that you have to restart the GO Computer, open the GO file Service.INI in the subdirectory BOOT in the directory PenPoint on Disk 1. Add the line \DISK4\PenPoint\Service\TOPS
Verifying the Connection

To make sure that TOPS is running on your PC, turn to your GO Computer, double tap the icon of the diskviewer in the bookshelf. You should see icons for each published PC volume at the top of the diskviewer page.

If you don't see the published volumes, check all your cables, make sure that you have loaded TOPS on your PC, and try again. If the diskviewer still does not show your published volumes, try setting up TOPS on another PC, to eliminate the possibility that the problem lies in MS-DOS.

To make sure that PenPoint is using its own version of TOPS, open the Installer, turn to the Services Page, and make sure that TOPS appears in the list of installed services.
You're ready to transfer documents, software, fonts, and other PenPoint materials between your GO Computer and the published PC volumes.

- For step-by-step procedures for preparing your PC and publishing, see chapter 3, "Working with Files on the PC."

- For instructions on exchanging files, see chapter 4, "Exchanging Files."
With TOPS running on the PC connected to your GO Computer, you can use any PC disk drive or directory to

- store back-up copies of documents you create on the GO Computer
- store PC documents you intend to convert to PenPoint format, to import into the GO Computer
- make some documents available to colleagues who share the PC or have PC's on the network
- store programs that you want to add to your GO Computer
- store the software that can restart the GO Computer
- store fonts you may want to use when you work on the GO Computer, or when you print.

The PC disk drive or directory is known as a volume. On your PC, you can use regular MS-DOS commands to copy files directly from floppy disks into a PC volume such as a directory on your hard disk. And on your GO Computer, you can use the Disk Viewer to move or copy documents, fonts, and applications to or from the PC volume.

To be able to see the contents of a PC volume on the screen of your GO Computer, you first need to publish that volume. Publishing makes the contents of a disk drive or directory visible to your GO Computer. You publish using TOPS on the PC.

This chapter explains how to use TOPS on the PC to prepare for file transfer between the PC and the GO Computer. You will learn how to:

- start TOPS on the PC
- publish a PC volume
- check exactly which volumes you have already published
✓ rename a volume

✓ set up some form of restricted access (important if you need to preserve some documents unchanged)

✓ unpublish a volume.

For information on copying files from a floppy disk to your PC hard drive, please look up the Copy command in your MS-DOS manual.

For information on transferring files between the two computers, see chapter 6 ("Exchanging Files"); and for information on restarting the GO Computer from the PC, see chapter 4 ("Exchanging Files").
Starting to Use TOPS on the PC

There are two occasions on which you must start TOPS on the PC: when you want to publish a PC volume, making it available to your GO Computer, and when you want to transfer files between your GO Computer and the PC volume.

When you installed TOPS on the PC, as described in chapter 2, "Quick Start," we suggested that you modify your AUTOEXEC.BAT file so that TOPS would start whenever you turn on your PC. During startup, a number of messages should appear announcing that the PC is loading various pieces of TOPS.

If you did not modify the AUTOEXEC.BAT file so that TOPS will start whenever you turn on your PC, or if you are not sure whether TOPS was loaded, go to the root directory, type LOADTOPS, and press Enter. For instance, if you start your computer from drive C, the root directory prompt might be C:\> and your command would look like this: C:\>LOADTOPS

Once TOPS has been loaded, you return to the system prompt. You can now start to use TOPS.

1 At the root directory, type
   TOPSMENU and press Enter

   You see the TOPS Main Menu.
   You are ready to use TOPS. The menus presented in TOPSMENU help you do all the work you need to on the PC.

   Commands

   Instructions

   When preparing the PC to transfer files with your GO Computer, you will use the File Services option, which lets you publish the files on a volume, and the Remember option, which preserves your choices for future use.

   To exit to DOS, press Control-Q.

   The TOPS Main Menu
Publishing a PC Volume

In order to store documents, programs, or fonts in a PC volume, you need to publish it. Publishing makes the contents of a disk drive or directory visible to your GO Computer. In essence, you are turning the PC disk drive or directory into a file server, a device that serves you by providing storage for your files.

Caution: Publishing makes the volume public, so if your PC is on a TOPS network, other people using the network will be able to see what is in the published volume, copy files from the volume, and store files in the volume.

1. At the TOPS Main Menu, choose File Services and press Enter.

To highlight an option, use the up or down arrow.

The File Service Main Menu appears.

Description of the highlighted option

Options

Instructions

2. Choose Server Utilities and press Enter.

These options will help you make your PC act as a file server.
The File Service Server Utilities menu appears.

Lets you see what is in a disk drive or directory and publish the volume

Lets you see which volumes you have already published

Lets you see if the GO Computer is using one of the published volumes now

Lets you decide whether to display your station name

**Publishing the Volume**

3 Choose Publish a Volume and press Enter

*Two screens:
1) The TOPS File Service Main Menu
2) The File Service Server Utilities Menu*

The File Service Publish-a-Volume screen appears.

4 To publish the entire contents of your hard disk, type its drive letter, for example, C, and press Enter

If you only want to publish a particular directory on a disk — not the entire contents of the disk — type the disk’s drive letter, then press F1. A list of directories appears. If you want to display nested subdirectories, select a directory and press F1 again, until you see the directory you want. Highlight the directory, and press Enter.

TOPS displays a pathname leading to the disk drive or directory

5 To confirm that this is the drive or directory you want to publish, press Enter
6 Type a meaningful name for the volume (up to 16 characters) and press Enter

This is the name that will appear in the diskviewer on your GO Computer

TOPS now asks if you want to assign a password. To make sure your GO Computer has access to the volume, you should choose No.

7 Do not type in a password. Press Enter to indicate you do not want a password

8 Define the kind of access you want to give yourself

✔ If you want to protect all the files in this volume from being changed accidentally, press Enter to confirm that you want the files you open to be Read-Only (R)

✔ If you want to be able to place new files into this volume and change the files that are already there, choose RW for Read-Write and press Enter

8 Press Escape twice to return to the TOPS Main Menu

The File Service Publish-a-Volume screen

You have now published this volume. You can publish other volumes as well, before going on.

Publication lasts as long as your PC stays on. To make sure that the PC publishes the volume every time you start TOPS, tell TOPS to remember what you have published.
On the TOPS Main Menu, choose Remember and press Enter.

Remember stores your current publishing decisions in a new batch file called TREMEMBR.BAT. Whenever you load TOPS, it runs this file, reactivating your publishing choices.

From now on, to be able to use this volume from your GO Computer, you just need to turn on your PC and load TOPS. You won't have to deal with publishing again unless you want to change or add volumes.
Displaying the Contents of a PC Volume

Sometimes you want to see what files a particular PC disk drive or directory contains. You can use TOPS to take a look.

1. At the TOPS Main Menu, choose File Services and press Enter.

   The File Service Main Menu appears.

2. From the File Service Main Menu, choose Server Utilities and press Enter.

   These options help you make your PC act as a file server.

   The File Service Server Utilities menu appears.

3. From the File Service Server Utilities menu, choose Publish a Volume and press Enter.

   You're not actually going to publish, but this option lets you view the contents of a disk drive or directory.

4. To view the entire contents of your hard disk, type its drive letter, for example, C, and press F1.

   A list of directories appears. If you want to display nested subdirectories, highlight a directory and press F1 again, until you see the subdirectory you want to explore. Highlight the subdirectory, and press F1.

   TOPS displays a pathname leading to the disk drive or directory. You
can now publish the directory if you wish, or escape if you don’t want to publish it.

5 To withdraw without publishing the directory, press Escape twice to return to the TOPS Main Menu.

If you decide that you do want to publish the directory, make sure that TOPS is displaying the pathname leading to the drive or directory you want to publish, then press Enter.

The File Service Publish-a-Volume screen
Listing What’s Been Published

You can find out which volumes you have published. At the same time, you can also see if the GO Computer recognizes that it has access to the volume.

1. At the TOPS Main Menu, choose File Services and press Enter
   The File Service Main Menu appears.

2. Choose Server Utilities and press Enter
   The Server Utilities menu appears.
   Lets you see which volumes you have already published

3. Choose Volumes Published and press Enter
   You see a list of the volumes published from your PC as a file server.

   Information about Volumes Published
   The name you gave to the volume
   The pathname leading to the volume
   R means you can only read the files in the volume; RW means you can read and write the files.
   You can now find out if a volume is currently recognized by the GO Computer.

4. To see if a volume is currently in use by the GO Computer, highlight the volume and press Enter

   If the volume has been recognized by a client such as the GO
Computer, TOPS shows the workstation name of the client in a box on the right. The workstation name for your GO Computer is usually your last name, plus GO. By the way: If your PC is part of a TOPS network, you may see the names of other clients in this box.

5 Press Escape twice to return to the TOPS Main Menu

The File Server Publish-a-Volume Screen
Changing the Name or Access of a Published Volume

If you want to change the name or type of access for a volume you have already published, you can do so without going through the process of publishing again. To prevent confusion, though, you can only modify the name and access when the volume is not currently in use.

That means you must turn off your GO Computer first. Here’s why. Whenever you turn on your GO Computer, the PenPoint operating system looks for any published PC volumes. The TOPS program on the PC recognizes that the GO Computer has access to the published volumes, and, assuming the GO Computer may "use" those files, TOPS makes sure that you do not change the name or access of the volume until the GO Computer is turned off.

1 Turn off your GO Computer.

2 At the TOPS Main Menu, choose File Services and press Enter

The File Service Main Menu appears.

3 On the File Service Main Menu, choose Server Utilities and press Enter

The Server Utilities menu appears.

Let's you see which volumes you have already published, and modify the name and access

4 On the Server Utilities menu, choose Volumes Published and press Enter
You see a list of the volumes published from your PC as a file server.

The name you gave to the volume Access: R means you can only read the files in the volume; RW means you can read and write the files.

You can modify the name and access only if the volume is not currently being used by a client such as the GO Computer.

5 To make sure that the volume is not currently in use, highlight the volume and press Enter

If the volume is being used, TOPS shows the workstation name of the client in a box on the right. If any name shows up in that box, you cannot proceed to modify the name and access until the client stops using the file.

6 Press Escape to put away the box with information about the current usage of the volume

7 With the volume still highlighted, press F2 to edit the volume’s name, or F6 to change the read/write access

By the way: R means you can only read the files in the volume; RW means you can read and write the files.

TOPS will remember the changes you make here if you previously asked TOPS to remember your publishing decisions.

8 Press Escape twice to return to the TOPS Main Menu

The File Server Publish-a-Volume Screen
Removing Access to a Volume (Unpublishing)

You can remove a volume from availability on your GO Computer or, if you are on a TOPS network, from public access, by unpublishing it. You might want to do this when a directory grows large and unwieldy, or when you reorganize your hard disk.

To prevent confusion, though, you can only unpublish when the volume is not currently in use.

That means you must turn off your GO Computer first. Here's why. Whenever you turn on your GO Computer, the PenPoint operating system looks for any published PC volumes. The TOPS program on the PC recognizes that the GO Computer has access to the published volumes, and, assuming the GO Computer may "use" those files, TOPS makes sure that you do not change the name or access of the volume until the GO Computer is turned off.

1. Turn off your GO Computer.

2. At the TOPS Main Menu, choose File Services and press Enter.

   The File Service Main Menu appears.

3. From the File Service Main Menu, choose Server Utilities and press Enter.

   The Server Utilities menu appears.

   Lets you see which volumes you have already published, and unpublish them.

4. From the File Service Server Utilities menu, choose Volumes Published and press Enter.
You see a list of the volumes published from your PC as a file server.

**Remember:** You can only unpublish a volume if the volume is not currently in use.

5 To make sure that the volume is not currently in use, highlight the volume and press Enter.

If the volume is being used, TOPS shows the workstation name of the client in a box on the right. If any name shows up in that box, you cannot unpublish until the client stops using the file.

6 Press Escape to put away the box with information about the current usage of the volume.

7 Make sure that the volume you want to unpublish is still highlighted, then press the Delete key.

This unpublishes the volume; it does not actually delete the volume or its contents.

7 Press Escape twice to return to the TOPS Main Menu.

*The File Server Publish-a-Volume Screen*

If you want TOPS not to publish this volume the next time you load TOPS, you need to tell TOPS to remember what you have just done.

8 On the TOPS Main Menu, choose Remember and press Enter.

From now on, whenever you start TOPS, this volume will remain invisible to your GO Computer and, if your PC is part of a TOPS network, to any of its clients.
Nothing terrible happens if your GO Computer screen freezes or goes blank while you are using a file you have copied from a PC volume. Your original is still stored in the PC volume. Start your GO Computer again, and copy the file again.

If you encounter any difficulty copying the file, the problem may just be that TOPS considers that document already "in use" by the GO Computer, and balks at letting you make a second copy. The crude solution: turn off your PC, turn it back on, and load TOPS again. For a more elegant solution, follow these steps on your PC.

1. At the TOPS Main Menu, choose File Services and press Enter

   The File Service Main Menu appears.

2. Choose Server Utilities and press Enter

   The Server Utilities menu appears.

   Lists any client who is currently using one of your published volumes

3. Choose File Clients and press Enter

   TOPS lists the workstations it thinks are currently using your published PC volumes. If your GO Computer appears in this box, even though it has crashed, you should delete its name.

   **Caution:** Do this only in emergencies. If you do this while the GO Computer is still running, you could have difficulty storing the document back in the PC volume.

4. Highlight the GO Computer name and press the Delete key

   TOPS no longer considers the GO Computer an active client for the PC volume. You can return to the
GO Computer and use the Disk Viewer to look at the published volumes on the PC and copy the file you were working on.

5 Press Escape twice to return to the TOPS Main Menu

File Clients screen
Chapter 4: Exchanging Files

With TOPS running on the PC connected to your GO Computer, you can transfer documents, fonts, and software between the two computers.

From your GO Computer, you can send documents to a published PC volume such as a disk drive or directory:

✓ to store backup copies
✓ to make documents available to colleagues who share the PC or have PC's on the TOPS network.

Working at your GO Computer, you can also get documents, fonts, and software from any published PC volume:

✓ to copy previously stored GO documents back onto the GO Computer to work on them again
✓ to restore an earlier version of a document
✓ to copy a document created on the PC so you can read and revise it on the GO Computer
✓ to use the fonts or software on the GO Computer
✓ to load the PenPoint operating system into your GO Computer when you need to restart it.

This chapter explains how to transfer files back and forth. If you have already copied and moved documents around on the GO Computer, you will find the process familiar.

Make sure that your GO Computer is connected to the PC, and that TOPS has been loaded on the PC. Once you have used the PC to publish the contents of a disk drive or directory (as described in chapter 3, "Working with Files on the PC") you move to your GO Computer to carry out the actual exchange of files.

You direct all file transfers from your GO Computer. In the next section, we describe the different ways in which you can use your GO Computer to transfer a file from one computer to the other.
Overview: Different Ways to Transfer a File

There are several ways to transfer a document between your GO Computer and a published PC volume:

- **Copying** makes a new copy of the original file and transfers that copy from one computer to the other. Copying does not change the contents, location, or format of the original file.

- **Moving** takes your current version of a GO document from one computer and places it in a volume on the other computer. Once moved, the document no longer appears in the original computer's table of contents or directory; so moving makes room for other documents.

- **Importing** a file created on the PC converts its format so that it becomes a PenPoint document. You begin by copying or moving the document from the PC volume. PenPoint then asks you to specify the kind of stationery you want the document to be, and translates the format while importing the file to the GO Computer.

- **Exporting** a file created on the GO Computer converts its format so that it can be read and revised using PC software. For instance, you might export a Text Editor document as an MS-Word file, so that someone else can read the document with MS Word on the PC. Exporting leaves the original PenPoint file in place on the GO Computer.

You will find instructions for each method in this chapter.
Finding Out What’s in a Published Volume

When you are working at your GO Computer and want to see the contents of a published PC volume, you use the diskviewer. The diskviewer shows you an icon and name for each PC volume in a disk drive connected to the GO Computer, the PC, or any other PC on the TOPS network. You can then select a volume and find out what documents and sections it contains. Any PC file appears as a document in the diskviewer, and any PC directory appears as a section.

1 Tap the diskviewer icon on the bookshelf

Diskviewer icon

The diskviewer floats on the page. It displays an icon for any disk in a GO floppy disk drive, plus any published volumes in disk drives connected to the PC, or on the TOPS network.

Icons for any disks or published volumes available to the GO Computer

Area in which the diskviewer will display the contents of a selected disk or volume

2 Tap the volume icon to see the contents

A table of contents appears with the documents and sections in the disk or volume you selected. Sections appear in bold, files in plain text.

Dir stands for Directory, the PC term for a section

3 Double tap a section to see its contents

You can view the contents of several disks or volumes at once, if you wish
Document created on the GO Computer

File created on a PC

Document created on the GO Computer, then exported in a PC format

4 To close a volume's contents, tap the volume icon

If the titles do not all fit on the screen, flick on the page to scroll to the title you want

5 Tap the close/move corner to put the diskviewer away

Figure with three parts. First one is the Diskviewer icon on the bookshelf.

(2nd object) The Diskviewer

(screen) TOC with diskviewer floating on TOC and leader lines to callouts for menus, icons, area for toc's. Use the TOC from Filing.

(3rd Object) Diskviewer

(Screen) Volume such as PC Hard Disk appears as section name; indented within it are sections named Budget, Memos, Contacts (or whatever the sample docs use now) plus in plain text a file or two, callouts for GO document, PC document, exported document, volume icon, close/move corner.
Transferring Documents from the GO Computer

You can copy or move a document from the GO Computer to any published volume on the PC and, if the PC is part of a TOPS network, to any published volume on that network.

✔ If you intend to continue working on the document on the GO Computer, but want to make a backup copy on the PC volume, you should copy the document.

✔ If you want to store the document on the PC volume, but do not need it on the GO Computer, you should move the document.

If you want to use an MS-DOS program on your PC to read or revise the document, you should export the document, as described in the section on "Converting a PenPoint Document to a PC Format."

1 Turn to a GO table of contents containing the title of the document you want to copy or move

Now you need to indicate the location to which you want to copy or move the document.

2 Tap the diskviewer icon on the bookshelf
Diskviewer icon

The diskviewer floats on the page. It displays icons for any disk in a GO floppy disk drive, plus any published volumes in disk drives connected to the PC, or on the TOPS network.

You need to open any section into which you wish to place a document.

Icons for any disks or published volumes available to the GO Computer

Area in which the diskviewer displays the contents of a selected disk or volume

3 Tap the volume icon to expand the contents

A table of contents appears with the documents and sections in the disk or volume you selected.

Dir stands for Directory, the PC term for a section; sections appear in bold

Individual documents appear in plain text

4 Double tap the name to open the section you want to place the document in

You may need to expand the contents of several sections to get to the one you want

If the titles do not all fit on the screen, flick on the page to scroll to the title you want

5 When you have expanded the contents of the section into which you want to place the document, transfer the document
To copy, tap-hold and drag the document into the section

To move, press-hold, and when the marquee appears around the name, drag the document into the section

6 Tap the close/move corner to put the diskviewer away

Figure: at top: Diskviewer icon in the bookshelf

The Diskviewer

TOC with diskviewer floating on TOC, move gestures showing document being moved from TOC into an open section in the diskviewer. Diskviewer shows Volume such as PC Hard Disk appearing as section name; indented within it are sections named Budget, Memos, Contacts (or whatever the sample docs use now) plus in plain text a file or two. Callouts point to boldfaced section, plaintext file, icons for volumes and disks, area for toc
You can copy or move a document from any published volume on the PC and, if the PC is part of a TOPS network, from any published volume on that network, transferring the document to the GO Computer.

- **Copying** leaves the original document in place, and brings a copy into the GO Computer.

- **Moving** takes the original document off the PC volume, and places it on the GO Computer.

You can use your GO Computer to transport files created in MS-DOS applications by moving or copying them to your GO computer, taking your GO computer to another office and transferring that file to another PC to work on it.

But if you want to work on the document on the GO Computer, you'll need to import it. To import a document, see the next procedure, "Converting an MS-DOS File for Use on the GO Computer."

1. **Open a GO table of contents**

   To indicate exactly where you want the document to be placed in your notebook, you need to expand the section that will contain the document.

2. **Expand the section into which you want to place the document**

   Now that the section is open and waiting, you are ready to look at the PC volume and find the document you want to transfer.

3. **Tap the diskviewer icon on the bookshelf**
Diskviewer icon

The diskviewer floats on the page. It displays icons for any disk in a GO floppy disk drive, plus any published volumes in disk drives connected to the PC, or on the TOPS network.

You need to open the section (or directory) containing the file you want to transfer.

Icons for any disks or published volumes available to the GO Computer Area in which the diskviewer displays the contents of a selected disk or volume

4 Tap the volume icon to expand the contents

A table of contents appears with the documents and sections in the disk or volume you selected.

Dir stands for Directory, the PC term for a section; sections appear in bold

Individual documents appear in plain text

5 Double tap the name to open the section containing the document

You may need to expand the contents of several sections to get to the one containing the document

If the titles do not all fit on the screen, flick on the page to scroll to the title you want

6 When you have opened the section containing the document, transfer the document

✔ To copy, tap-hold and drag the document into the GO table of contents

✔ To move, press-hold, and when the marquee appears
around the name, drag the
document into the GO
table of contents

7 Tap the close/move corner to put
the diskviewer away.

Figure: top with Diskviewer icon in the bookshelf

 objections)The Diskviewer
(screen) TOC with diskviewer floating on TOC, Diskviewer shows Volume such as
PC Hard Disk appearing as section name; indented within it are sections named
Budget, Memos, Contacts (or whatever the sample docs use now) plus in plain text
a file or two. Callouts point to boldfaced section, plaintext file, icons for volumes and
disks, area for toc, toc

By the way: If the document was
created in an MS-DOS application,
you need to convert it to PenPoint
format to work with the document
on your GO Computer. PenPoint
presents you with the Import
option sheet. For details on this
option sheet, please see the next
procedure, "Converting an MS-DOS
File for Use on the GO Computer."
Converting an MS-DOS File for Use on the GO Computer

If you want to work with a file created in an MS-DOS application after you've transferred it to the GO Computer, you need to convert it to PenPoint format. PenPoint carries out that conversion during the transfer, importing the file. The original file remains in the PC volume, unchanged.

1. Open a GO table of contents

   To indicate exactly where you want the document to be placed in your notebook, you need to expand the section that will contain the document.

2. Double-tap to expand the section into which you want to place the document

   When the section is open and waiting, you are ready to go over to the PC volume and find the document you want to import.

3. Tap the diskviewer icon on the bookshelf
Diskviewer icon

The diskviewer floats on the page. It displays icons for any disk in a GO floppy disk drive, plus any published volumes in disk drives connected to the PC, or on the TOPS network.

You need to open the section (or directory) containing the file you want to import.

Icons for any disks or published volumes available to the GO Computer

Area in which the diskviewer displays the contents of a selected disk or volume

4 Tap the volume icon to expand the contents

A table of contents appears with the documents and sections at the top level in the disk or volume you selected.

Dir stands for Directory, the PC term for a section; sections appear in bold

Individual documents appear in plain text

5 Double tap the name to open the section containing the document

You may need to expand the contents of several sections to get to the one containing the document

If the titles do not all fit on the screen, flick on the page to scroll to the title you want

6 When you have opened the section containing the document, transfer the document
To copy, tap-hold and drag the document into the GO table of contents.

To move, press-hold, and when the marquee appears around the name, drag the document into the GO table of contents.

If the document was created in an MS-DOS application, you need to convert it to PenPoint format to work with the document on your GO Computer. PenPoint displays the Import option sheet.

DOS name for the file

Name you want to use for the document on the GO Computer

Program you will use to work on this document on the GO Computer

To change the document name for use on the GO Computer, draw a [(cross out)] on the proposed file name, and write in a new name.

Tap the popup menu to open it, then select the program you will use to work on this document on the GO Computer.

Tap the Import button to continue transferring the document, and converting its format.

Tap here to close the option sheet without importing the document.

Tap the close/move corner to put the diskviewer away.

Figure starts with Diskviewer icon in the bookshelf

(2nd object) The Diskviewer

(screen) TOC with diskviewer floating on TOC, Diskviewer shows Volume such as PC Hard Disk appearing as section name; indented within it are sections named Budget, Memos, Contacts (or whatever the sample docs use now) plus in plain text a file or two. Callouts point to boldfaced section, plaintext file, icons for volumes and disks, area for toc.

(3rd Object) Import option sheet
(Screen) Show leader lines to each line of the sheet, cross out on import name text, new title written in, show popup with Text Editor selected, leader lines to Import, and Cancel buttons
Converting a GO Document to MS-DOS Format

The Export command on the Document menu converts a copy of a GO document to a format that an MS-DOS program can read, then places that copy on a published PC volume. Your original GO document remains on the GO computer.

1. Select the document in a GO table of contents

2. Choose Export from the Document menu

   The Export dialog sheet appears, with your document's name at the top.

   Lets you edit the name of the document for use on the PC

   Lets you pick the format you want the document converted into

   Lets you specify the volume and section into which you want the converted document placed

3. Tap the suggested Export Name, then rewrite.

   The PC expects a file name of no more than 8 characters, followed by a 3-letter extension indicating the file's format. Consult your MS-DOS program's manual for the appropriate extension, such as .wks for a worksheet made in Lotus 123, or .rtf for a Microsoft Word document in Rich Text Format.

4. Tap the Export Format popup menu, then tap the format you want the document converted into

5. Double tap the icon of the volume you want to place the document in
6 Double tap a section to expand its contents

You need to open whatever section you want to place the document in.

7 Tap the Export button

PenPoint makes a copy of the document, converts that to the PC format, renames the copy, and places it in the section you opened.

8 Tap the move/close corner to dismiss the Export option sheet

(Object) Export dialog sheet

(Screen) Export dialog sheet with Bottle document, leader lines to Export Name, Export Format, and area below the message, "Please Select Destination."
Installing Software from the PC

(Not available in alpha release)

You can load PenPoint software into the GO Computer from a published volume on your PC. The volume can be either a floppy disk or a directory on a hard disk.

If you want to store the software on your PC hard disk, place it in a subdirectory named APPS inside another directory called PENPOINT. Make sure that the PENPOINT directory is at the top level of a published PC volume.

If you are using a floppy disk directly from the program's manufacturer, the program will probably already be placed inside a PENPOINT directory in a subdirectory called APPS.

1 Tap the Installer icon

The Installer option sheet appears listing the programs that are already installed on your GO Computer.

Popup menu

3 Tap the popup menu to see a list of PenPoint materials you can install

4 Select Applications from the popup menu

A list of currently installed programs appears.

5 Tap the Install from Disk button

The Install from Disk option sheet appears, showing any published PC volumes.

6 Tap the volume you want to install from

PenPoint lists any programs it finds in the subdirectory APPS inside a directory PENPOINT at the top level of that volume.

7 Tap to select the program you want to install
8 Tap the Install button

PenPoint installs the program on your GO Computer; the program appears on the list of Installed Applications, and its stationery is placed in the Stationery notebook or, if it is an accessory like the Clock, in Accessories.

9 Tap the move/close corner to put away the Installer option sheets

*Figure starts with the Installer icon
(2nd Object) The installer option sheet
(Screen) Show installer option sheet with its default Installed...Handwriting title.
Leader line to Handwriting (the popup menu)
(3rd Object) Installer option sheet with title Installed Applications
(Screen) show clock, whatever comes up, leader line to Install from Disk button, which sometimes appears at the bottom
Installing Fonts from the PC

(Not available in alpha release)

You can load PenPoint fonts into the GO Computer from a published volume on your PC. The volume can be either a floppy disk or a directory on a hard disk.

If you want to store the font on your PC hard disk, place it in a directory called FONT inside another directory called PENPOINT. If you are using a floppy disk directly from the program's manufacturer, the program will probably already be placed inside a PENPOINT directory called FONT.

1 Tap the Installer icon

The Installer option sheet appears listing the programs that are already installed on your GO Computer.

Popup menu

3 Tap the popup menu to see a list of PenPoint materials you can install

4 Select Fonts from the popup menu

A list of currently installed fonts appears.

5 Tap the Install from Disk button

The Install from Disk option sheet appears, showing any published PC volumes.

6 Tap the volume you want to install from

PenPoint lists any programs it finds in the subdirectory FONT inside a directory PENPOINT at the top level of that volume.

7 Tap to select the font you want to install
8 Tap the **Install** button

PenPoint installs the font on your GO Computer; the font appears on the list of **Installed Fonts**. From now on, you will be able to use this font in your GO documents.

9 Tap the move/close corner to put away the Installer option sheets

*Figure begins with the Installer icon*

*(2nd Object)* **The installer option sheet**

*(Screen)* Show installer option sheet with its default Installed...Handwriting title. Leader line to Handwriting (the popup menu)

*(3rd Object)* **Installer option sheet with title Installed Fonts**

*(Screen)* show clock, whatever comes up, leader line to Install from Disk button, which sometimes appears at the bottom
Loading PenPoint from the PC

(Not available in alpha release).

Sometimes things go wrong. If your GO Computer stops, you can usually start it again by pressing the On/Off button, at the top right corner of the notebook. You should see the familiar notebook and bookshelf come to life again on your screen. If nothing happens, though, you need to load the PenPoint operating system from a floppy disk or from a hard disk attached to your PC.

If you want to store the PenPoint operating system on your PC hard disk, place it in a subdirectory named BOOT inside a directory named PENPOINT. Then publish the PenPoint directory (or the entire hard disk).

If you want to restart from floppy disks, make copies of your original PenPoint disks, then put the working copy of the first PenPoint disk into your PC drive. Publish that drive.

Publishing makes the contents of the disk drive or directory available to the GO Computer. When you restart the GO computer, it looks for a directory named PENPOINT, and a subdirectory named BOOT, and, finding them, loads the PenPoint operating system from BOOT.

1 With the GO Computer switched on, insert the end of a paperclip in the Restart spot.

The GO Computer should beep after a moment. If it does not beep, wait a little longer, and if silence persists, press the On\Off button again, then poke the Restart hole again. (The computer was probably off.)

You now see the disk drive light come on, indicating that the GO Computer is reading the PenPoint operating system from the disk.

2 Follow the instructions, if any appear

If you are loading from a floppy disk, you may be told to insert a second disk.

The PenPoint notebook appears, open to the document you were
working on when the problem occurred.

*Diagram: The Restart spot, showing where it is on the back*